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法律资讯

警告提示系统

为了您的人身安全以及避免财产损失，必须注意本手册中的提示。人身安全的提示用一个警告三角表示，仅与财产

损失有关的提示不带警告三角。警告提示根据危险等级由高到低如下表示。

危险

表示如果不采取相应的小心措施，将会导致死亡或者严重的人身伤害。

警告

表示如果不采取相应的小心措施，可能导致死亡或者严重的人身伤害。

小心

表示如果不采取相应的小心措施，可能导致轻微的人身伤害。

注意

表示如果不采取相应的小心措施，可能导致财产损失。

当出现多个危险等级的情况下，每次总是使用最高等级的警告提示。如果在某个警告提示中带有警告可能导致人身

伤害的警告三角，则可能在该警告提示中另外还附带有可能导致财产损失的警告。

合格的专业人员

本文件所属的产品/系统只允许由符合各项工作要求的合格人员进行操作。其操作必须遵照各自附带的文件说明，特

别是其中的安全及警告提示。 由于具备相关培训及经验，合格人员可以察觉本产品/系统的风险，并避免可能的危

险。

按规定使用 Siemens 产品

请注意下列说明：

警告

Siemens 产品只允许用于目录和相关技术文件中规定的使用情况。如果要使用其他公司的产品和组件，必须得到 
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必须保证允许的环境条件。必须注意相关文件中的提示。

商标

所有带有标记符号 ® 的都是西门子股份有限公司的注册商标。本印刷品中的其他符号可能是一些其他商标。若第三
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WinCC/WebNavigator 使用入门 1
1.1 第一个 Web 项目

简介 

WinCC/WebNavigator 为操作员通过 Intranet 或 Internet 监控自动化系统提供了解决方

案。 WinCC/WebNavigator 提供了简单有效的方法来实现 WinCC 项目的操作员监控功能。

可选的“WinCC/WebNavigator”包由安装在 WebNavigator 服务器上的服务器组件组成。 
在用来控制和监视 WinCC 基本系统中所显示的过程画面的计算机上，需要具备 
WebNavigator 客户端组件。 为此，请在客户端上使用 Internet Explorer 或 
"WinCCViewerRT" Web 查看器。

WinCC/WebNavigator 也包含“WebNavigator 诊断客户端”组件。 此诊断客户端的功能

与 WebNavigator 客户端的功能并无不同。 诊断客户端可针对诊断目的，让您在兼具成本

效益与可靠性的情况下，访问一个或多个 WebNavigator 服务器。

概述

本《入门指南》基于 WinCC 演示项目。 对于此示例项目，WinCC、WebNavigator Server 
和 WebNavigator 客户端安装在同一台计算机上。 

编辑 WebNavigator 服务器上的 WinCC 项目。 如果通过 Internet Explorer 或 
"WinCCViewerRT" 访问项目，则使用 WebNavigator 客户端。

先决条件

● 已安装 WinCC 基本系统。

● 已安装 WinCC 演示项目。 有关安装的信息，请参见“WinCC 演示项目的安装信息”章

节。

● 已安装 WebNavigator 服务器。 有关安装的信息，请参见“WebNavigator 服务器的安装

信息”章节。

WinCC/WebNavigator
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步骤

第一个 Web 项目执行以下步骤：

● 组态 WinCC 项目

– 发布用于 Web 访问的 WinCC 过程画面

– 管理 WebNavigator 客户端的用户

● 组态 WebNavigator 服务器

– 组态 WebNavigator 网页

– 组态防火墙

– 检查激活的网页

● 打开 WinCC 项目

– 组态 Internet Explorer 设置

– 安装 WebNavigator 客户端并使用 Internet Explorer 打开 WinCC 项目

– 设置 WinCCViewerRT，并使用 WinCCViewerRT 打开 WinCC 项目 

● 创建新过程画面并在 WebNavigator 客户端上进行显示

参见

创建一个新的过程画面 (页 29)

安装 WebNavigator 客户端 (页 23)

管理 WebNavigator 客户端的用户 (页 13)

启动演示项目 (页 16)

WinCC/WebNavigator 使用入门
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1.2 组态 WinCC 项目

1.2.1 发布过程画面

简介

如果想要在 WebNavigator 客户端显示 WinCC 过程画面，就必须先发布画面。 如需发布

图片，可使用可自动对项目数据进行必要调整的 Web View Publisher 来进行。 

WinCC/WebNavigator 使用入门

1.2 组态 WinCC 项目
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步骤

1. 在 WinCC 项目管理器的浏览窗口中选择“WebNavigator”。
从快捷菜单中选择“Web View Publisher”命令。 WinCC Web 发布向导随即启动。

2. 单击“下一步”(Next)。

WinCC/WebNavigator 使用入门

1.2 组态 WinCC 项目
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3. 选择“WinCC 项目的路径”(Path to your WinCC project) 下方的 WinCC 项目文件夹。
在“WinCC Web 的发布文件夹”(Publishing folder of the WinCC Web) 中，选择已发布画面
的目标文件夹。 
接受 WinCC 项目文件夹中推荐的文件夹。
单击“下一步”(Next)。 

WinCC/WebNavigator 使用入门

1.2 组态 WinCC 项目
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4. 将要发布的画面移至“所选文件”(Selected files) 列表。

单击“下一步”(Next)。

WinCC/WebNavigator 使用入门
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5. 将必要的 C 项目函数移至“所选文件”(Selected files) 列表。

单击“下一步”(Next)。

WinCC/WebNavigator 使用入门

1.2 组态 WinCC 项目
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6. 将用在过程画面中的图形移至“所选文件”(Selected files) 列表。引用文件位于“GraCS”文
件夹或“GraCS”的子文件夹中。

单击“下一步”(Next)。

7. 要启动发布画面，单击“完成”(Finish)。

WinCC/WebNavigator 使用入门
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结果

结果列表显示已发布对象的状态。 可以单击某个对象来查看其它对象信息。 

您已成功发布了画面和函数。

1.2.2 管理 WebNavigator 客户端的用户

简介

为使用户能通过 WebNavigator 客户端访问 WinCC 项目，必须把适当的权限分配给 WinCC 
用户管理器的用户。 可以为每个用户选择不同起始画面和运行系统语言。 

WinCC/WebNavigator 使用入门
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步骤

1. 右键单击 WinCC 项目管理器浏览窗口中的“用户管理器”。 从快捷菜单中选择“打开”
(Open) 命令。 

2. 可以使用 Web 项目的现有用户。 例如，选择名为“winccd”的用户，其登录名称已分配
为“winccd”，密码已分配为“winccpass”，或基于此模板创建一个新用户。

3. 如果要创建新用户，请在导航区域的组快捷菜单中选择“新建用户”(New User) 命令。

4. 在“密码”(Password) 列中为新用户指定密码。

5. 在用户管理器的表格窗口中选择新用户。

6. 在数据窗口中，选中“WebNavigator”复选框。 

7. 在“Web 起始画面”(Web start picture) 中，通过下拉列表为用户选择起始画面（例
如，“winccPic.pd_”）。 只能选择已发布的画面作为起始画面。  

8. 在“Web 语言”(Web language) 中，通过下拉列表为用户选择运行系统语言。 文本库中创建
的语言可供选择。

WinCC/WebNavigator 使用入门
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9. 在用户管理器的浏览窗口中选择新用户。 在表格窗口的“授权”(Authorization) 列中，通过
单击选择所需的用户权限。 如果已启用系统授权“Web 访问 - 仅监视”，则仅允许用户作
为 WebNavigator 客户端监视 WinCC 项目。

10.关闭用户管理器。

WinCC/WebNavigator 使用入门
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1.3 组态 WebNavigator 服务器

1.3.1 启动演示项目

简介

您已将 WinCC 演示项目复制到计算机。 在此步骤中，您要针对作为 WebNavigator 服务

器和 WebNavigator 客户端的电脑设定 Web 项目。  

步骤

1. 在 Windows 开始菜单中，通过选择“Simatic > WinCC > WinCC 项目管理器”(SIMATIC > 
WinCC > WinCC Explorer) 启动 WinCC。

2. 打开“DemoProjectV7”。

3. 在下一个对话框中，单击“从本地启动服务器”(Start server locally)。 只有当用户的计算机
已经被作为可用的服务器输入计算机列表后，此 WinCC 项目才可能激活。

4. 在 WinCC 项目管理器的浏览窗口中，右键单击“计算机”(Computer) 并选择“属性...”
(Properties...)。

5. 单击对话框中的“属性”(Properties) 按钮。

6. 在“计算机名称”(Computer name) 字段中输入计算机名称。

7. 单击“确定”(OK)。 重新启动项目以便激活更改。

8. 选择“文件 > 退出”(File > Exit) 关闭项目。

9. 再打开演示项目以组态 WebNavigator 服务器。

参见

组态 WebNavigator 网页 (页 16)

1.3.2 组态 WebNavigator 网页

简介

WinCC Web Configurator 用于设置和管理 Microsoft Internet 信息服务 (IIS)。 这一步骤

中，您将会创建默认网页。

WinCC/WebNavigator 使用入门
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先决条件

● 已安装 WebNavigator 服务器。

● 已安装 Windows“Internet 信息服务”组件。

WinCC/WebNavigator 使用入门

1.3 组态 WebNavigator 服务器
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步骤

1. 在 WinCC 项目管理器的浏览窗口中选择“WebNavigator”。
从快捷菜单中单击“Web Configurator”命令。 
在起始页面上单击“下一步”(Next)。

2. 启动“新建标准网页（独立）”(Create a new standard web page (standalone)) 选项，然后
单击“下一步”(Next)。

WinCC/WebNavigator 使用入门

1.3 组态 WebNavigator 服务器
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3. 输入该网页的名称“WebNavigator”。

4. 在“端口”(Port) 字段中选择默认端口“80”。

5. 选择“IP 地址”。 用户只能使用选择列表中提供的地址。
选择“未分配全部”(All not assigned) 即可通过 Intranet 和 Internet 访问计算机。

6. 选择“WebClient.asp”作为默认网页。

7. 如果尚未激活防火墙，则单击“完成”(Finish)。
如果已经安装防火墙，则单击“下一步”(Next)。

结果

创建了 Web 文件夹并激活了网页。  

1.3.3 组态防火墙

简介  

本节将以 Windows 7 和 Windows Server 2008 R2 为例介绍如何为端口“80”激活“HTTP”
和“HTTPS”服务。

如果您想以高级安全性或针对不同端口设置 Windows 防火墙，请咨询您的网络管理员。

WinCC/WebNavigator 使用入门
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要求

● 已经使用 Web Configurator 创建了默认网页。

● 防火墙已激活。

● 登录的用户具有 Windows 管理员权限。

● 如果 WebNavigator 使用 HTTPS 服务，则必须在 IIS 中设置 HTTPS 服务。有关更多

信息，请参见“在 IIS 中设置 HTTPS 服务 (http://support.microsoft.com/kb/
324069)”。

默认端口的设置步骤

1. 在“WinCC Web Configurator”中，单击“Windows 防火墙”(Windows Firewall)。

“Windows 防火墙”(Windows Firewall) 对话框随即打开。

2. Windows 7：单击“允许程序或功能通过 Windows 防火墙”(Allow a program or feature 
through Windows Firewall)。
Windows Server 2008 R2：单击“允许程序通过 Windows 防火墙通信”(Allow a program to 
communicate through Windows Firewall)。

3. 激活“安全 WWW 服务 (HTTPS)”(Secure WWW services (HTTPS)) 或“WWW 服务 (HTTP)”
(WWW services (HTTP))。

4. 单击“确定”(OK) 关闭所有 Windows 对话框。

5. 在 Web Configurator 中单击“完成”(Finish)。
服务器组态完成。

WinCC/WebNavigator 使用入门

1.3 组态 WebNavigator 服务器

WinCC/WebNavigator
20 系统手册, 02/2017

http://support.microsoft.com/kb/324069
http://support.microsoft.com/kb/324069


1.3.4 检查激活的网页

Windows 7/Windows Server 2008 R2 的操作步骤  

1. 从 Windows 开始菜单选择“所有程序 > 管理 > Internet 信息服务 (IIS) 管理器”(All programs 
> Administration > Internet Information Services (IIS) Manager)。

2. 在“连接”(Connections) 字段中单击计算机名称。

3. 单击“默认 Web 站点”(Default Web Site)。

4. 检查网页视图。
如果在需要的网页（例如“WebNavigator”）旁边显示状态“停止”，则需要启动网页。
从快捷菜单中选择“启动”(Start) 命令以启动网页。

5. 选择“Internet 信息服务 (IIS) 管理器”(Internet Information Services (IIS) Manager)。将激活
网页。

WinCC/WebNavigator 使用入门

1.3 组态 WebNavigator 服务器
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1.4 打开 WinCC 项目

1.4.1 使用 Internet Explorer 操作 WinCC 项目

1.4.1.1 Internet Explorer 设置

简介       

要使用 WebNavigator 客户端上的全部功能，必须调整 Internet Explorer 的安全设置。 

步骤

1. 在 Internet Explorer 中，单击“工具 > Internet 选项”(Tools > Internet Options)。

2. 选择“安全”(Security) 选项卡。
然后选择相应的区域，例如，“本地 Intranet”或“Internet”。

3. 单击“自定义级别...”(Custom Level...)。

4. 启用“对标记为可安全执行脚本的 ActiveX 控件执行脚本”(Script ActiveX controls marked 
safe for scripting) 和“下载已签名的 ActiveX 控件”(Script ActiveX controls marked safe for 
scripting) 选项。

5. 在“脚本”(Scripting) 下启用“活动脚本”(Active Scripting) 选项。

6. 单击“确定”(OK)。 在随后的对话框中执行修改。

7. 单击“受信任的站点”(Trusted Sites) 图标。
单击“站点...”(Sites...) 按钮，打开“受信任的站点”(Trusted sites) 对话框。

8. 在“将该网站添加到区域中”(Add this website to the zone) 字段中，输入 WebNavigator 服
务器的地址。 可能的格式和占位符包括“*://157.54.100 - 200”、“ftp://157.54.23.41”
或“http://*.microsoft.com”。
取消激活“对该区域中所有站点需要服务器验证 (https:)”(Require server verification (https:) 
for all sites in this zone)  选项。 
单击“添加”(Add)。单击“确定”(OK)。

9. 单击“受信任的站点”(Trusted Sites) 图标。
单击“默认级别”按钮，然后单击“自定义级别”按钮。 
启用“对没有标记为安全的 ActiveX 控件进行初始化和脚本运行”(Initialize and script ActiveX 
controls not marked as safe)。单击“确定”(OK)。

10.单击“常规”选项卡。
在“Internet 临时文件”区域中单击“设置”按钮。
启用“检查所存网页的较新版本：”(Check for newer versions of stored pages:) 下的“自
动”(Automatic) 选项。
单击“确定”(OK)。

11.单击“确定”关闭“Internet 选项”对话框。
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1.4.1.2 安装 WebNavigator 客户端

简介

本章介绍在 WebNavigator 服务器上如何通过 Intranet/Internet 安装 WebNavigator 客户

端。

先决条件

● 已安装 WebNavigator 服务器。

● 已安装“WinCC WebNavigator”许可证。

● WinCC 项目已运行。

● 已组态和发布 WinCC 画面用于 Web 访问。

● 已在 WinCC 中创建了 WebNavigator 客户端的用户。

● Internet Explorer

步骤

1. 转到 Internet Explorer 的地址栏并输入 WebNavigator 服务器的 URL“http://www.<服务器名
称>”。

2. 键入用户名和密码，例如，“winccd”。
如果您是第一次访问 WebNavigator 服务器，系统会提示您安装 WebNavigator 客户端。 请
单击该链接 "Click here to install"。 

3. 单击“文件下载”(File Download) 对话框中的“保存”(Save)，以将客户端设置保存到目标计
算机上。 将客户端安装程序储存到客户端电脑上，可让你在必须重启计算机的情况下，不
必再次下载数据。

4. 在下一个对话框中，选择 WebNavigator 客户端安装文件的目标文件夹。  

5. 在不关闭 Internet Explorer 的情况下，打开 Windows 资源管理器。 浏览到保存安装文件的
文件夹。 通过双击 setup.exe 启动安装。

6. 按照屏幕上的指示进行操作，并进行必要的输入和设置。

7. 在“安装类型”(Setup type) 对话框中选择“完整”(Complete) 选项，以安装客户端的所有组
件。单击“下一步”(Next)。

8. 在下一个对话框中，单击“安装”(Install)。

9. 单击“安装向导已完成”(Install Wizard completed) 对话框中的“完成”(Finish)。

结果

成功安装之后，WebNavigator 客户端即连接到目前在运行系统中的 WinCC 项目。 标准网

页会显示出来，同时会显示您在用户管理员中为用户指定的画面。
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在 WebNavigator 客户端安装期间，也安装了 "WinCCViewerRT" Web 查看器。

"WinCCViewerRT" 是一种查看程序，此程序可代替 Internet Explorer 来查看 WinCC 项
目。

1.4.2 使用 WinCCViewerRT 操作 WinCC 项目

1.4.2.1 组态 WinCCViewerRT

简介           

WinCCViewerRT 是用于显示 WinCC 项目的程序。用户可以组态 WinCCViewerRT 以与 
WebNavigator 服务器和 Graphics Runtime 一同运行。

要求

● 在服务器上

– 已安装 WebNavigator 服务器。

– 已安装 WinCC/WebNavigator 许可证。

– WinCC 项目已运行。

– 已组态和发布 WinCC 画面用于 Web 访问。

● 在客户端上

– 已安装 WebNavigator 客户端。
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步骤

1. 双击“Webnavigator\Client\bin”安装文件夹中的链接“WinCCViewerRT.exe”。
如果重新组态 WinCCViewerRT，则组态对话框打开。 
如果已设置了 WinCCViewerRT，则 WinCCViewerRT 打开。使用 <Ctrl+Alt+P> 组合键打
开 WinCCViewerRT 的组态对话框。

2. 在“常规”(General) 选项卡中输入登录数据：

– 服务器地址：http://<服务器名称> 或 http://<IP 地址>
– 用户名和密码，如果想为登录对话框指定默认用户。

– 如果启用“应用项目设置”(Apply project settings) 选项，将激活在用户管理器中组态

的用户设置。

3. 在“参数”(Parameters) 选项卡中指定运行系统语言。
如有需要，禁用用户用于切换到其它程序的所有组合键。 
如有必要，可修改预置的用于打开 WinCCViewerRT 组态对话框的 <Ctrl+Alt+P> 组合键。
定义用户可注销而另一个新用户可登录的组合键。如果在“常规”(General) 选项卡中未设置
任何默认用户，只能使用组合键。

WinCC/WebNavigator 使用入门

1.4 打开 WinCC 项目

WinCC/WebNavigator
系统手册, 02/2017 25



4. 在“Graphics Runtime”选项卡中，指定 WinCC Runtime 属性：
- 起始画面
- 用户定义的菜单和工具栏的组态文件
- 窗口属性
- 不允许的用户操作

5. 在“运行系统”(Runtime) 选项卡中指定附加的用户操作：

● 激活屏幕键盘

● 使用 <Ctrl+Alt+Del> 组合键可通过屏幕键盘切换到任务管理器或操作系统。

● 自动注销设置

● 激活 Direct2D 来加速图像显示。

● 指定打印机，在 WinCC 控件中使用组态的打印作业执行打印。 

单击“确定”(OK) 关闭对话框。

结果

WinCCViewerRT 组态完毕。关闭对话框后便完成到 WebNavigator 服务器的连接的设置。

设置将被保存到 "WinCCViewerRT.xml" 组态文件中。组态文件设置将在下一次启动 
WinCCViewerRT 时使用。WinCCViewerRT 应用 WinCC 中的用户界面语言。

组态文件存储在以下文件夹中，具体取决于操作系统：

● <用户>\AppData\LocalLow\Siemens\SIMATIC.WinCC\WebNavigator\Client

可对文件进行重命名，例如重命名为“User1.xml”。
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还可以通过组合命令行与用户特定的组态文件来启动 WinCCViewerRT，例如 
"WinCCViewerRT.exe User1.xml"。此步骤允许使用不同的组态，具体取决于登录的用

户。 

如果重命名或删除 "WinCCViewerRT.xml"，则启动时会打开 WinCCViewerRT 组态对话

框。重新组态 WinCCViewerRT 或选择其它不同的组态文件。

说明

如果禁用快捷键或隐藏“关闭”(Close) 按钮，则只能通过脚本函数关闭 WinCCViewerRT。
C 脚本编写的函数：DeactivateRTProject；VBScript 编写的函数：HMIRuntime.Stop。

1.4.2.2 打开 WinCC 项目

先决条件       

● 在服务器上

– 已安装 WebNavigator 服务器。

– 已安装“WinCC WebNavigator”许可证。

– WinCC 项目已运行。

– 已组态和发布 WinCC 画面用于 Web 访问。

– 已在 WinCC 中创建了用户。

● 在客户端上

– 已组态 WinCCViewerRT。

步骤

1. 从 Windows“开始”(Start) 菜单选择“程序 > Siemens 自动化 > 选项和工具 > HMI 工具”
(Programs > Siemens Automation > Options and Tools > HMI Tools) 启动 
"WinCCViewerRT" 。

2. 登录到 WebNavigator 服务器：

– 如果已在 "WinCCViewerRT" 组态对话框中预置了用户名和密码，则不会显示登录对

话框。 会使用存储的登录数据自动登录。

– 如果未在 "WinCCViewerRT" 组态对话框中设置用户名和密码，则会显示登录对话

框。 输入 WinCC 用户的用户名和密码。 密码区分大小写。 单击“确定”(OK)。

3. 要更改用户，可使用为 "WinCCViewerRT" 登录/注销指定的组合键。 先前的用户将被注
销。 在登录对话框中输入新 WinCC 用户的用户名和密码。 密码区分大小写。 单击“确定”
(OK)。
只有未设置任何默认用户时才能使用组合键。
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结果

WinCCViewerRT 自动连接到已激活的 WinCC 项目。 将显示为用户组态的起始画面。 

根据分配的权限，用户可以操作或监视项目。 在用户管理中分配系统权限 1002“Web 访
问 - 仅监视”的用户只可监视 WinCC 项目。

“仅查看光标”表示不能执行过程相关的操作。 

某些操作仍然可以执行，如打开 WinCC OnlineTrendControl 的属性对话框。 

如有必要，可使用自己的光标图标作为“仅查看光标”。 有关详细信息，请参见“组态运

行系统设置 (页 56)”。

<F5> 键触发重新选择 WinCCViewerRT。
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1.5 创建新过程画面并在客户端上进行显示

1.5.1 创建一个新的过程画面

简介

在服务器上，针对 web 项目组态新过程画面。 创建趋势窗口，用于显示 WinCC 演示项目

归档中的测量值。

先决条件

●  WinCC 演示项目已打开。 
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步骤

1. 在 WinCC 浏览器的导航窗口中，单击“图形编辑器”(Graphics Designer)。 在数据窗口中
右键单击，选择“新建画面”(New picture) 菜单命令。

2. 在图形编辑器的对象选项板中，双击“控件”(Controls) 选项卡上的“WinCC 
OnlineTrendControl”。 控件即会插入到画面中，并且组态对话框会开启。 
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3. 单击“趋势”(Trends) 选项卡。 单击“数据连接”(Data connection) 字段中变量名处的 。 
在“归档/变量选择”(Archive/tag selection) 对话框中选择“测量值”归档和“T01”变量。

4. 单击“确定”(OK)。 “T01”中的测量值将链接到趋势。

5. 如果需要，组态趋势或控件的其它属性。

6. 以“NewTrend.pdl”名称保存控件，并关闭图形编辑器。
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结果

在 WebNavigator 服务器上已成功创建画面中的趋势窗口。 为了在 WebNavigator 客户端

上显示趋势窗口，您必须发布画面并将其指定为用户的起始画面。 

参见

组态新的 web 过程画面。 (页 32)

1.5.2 组态新的 web 过程画面。

简介

为了在 WebNavigator 客户端上显示趋势窗口，您必须发布画面并将其指定为用户的起始

画面。

先决条件

● WinCC 演示项目已打开。

● 在 WebNavigator 服务器上已成功创建画面中的趋势窗口。

步骤

1. 右键单击 WinCC 项目管理器浏览窗口中的“WebNavigator”。 从快捷菜单中选择“Web View 
Publisher”命令。

2. 在发布向导“选择画面”(Select pictures) 对话框的“文件”字段中选择新的“NewTrend.pdl”
画面。 将文件移至“所选文件”(Selected files) 列表。

3. 请遵循发布向导的进一步说明进行操作。 完成向导之后将发布画面。

4. 右键单击 WinCC 项目管理器浏览窗口中的“用户管理器”(User Administrator)，并从快捷菜
单中选择“打开”(Open) 命令。

5. 从用户管理器的浏览窗口中，选择想要与新的趋势窗口一起显示的用户。

6. 在表格窗口中，选中“WebNavigator”复选框。将显示“Web 选项”区域。

7. 单击“...”来选择“NewTrend.pd_”起始画面。

8. 关闭用户管理器。

结果

已成功组态包含在趋势窗口，以供在 WebNavigator 客户端上进行可视化的画面。     
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参见

在 WebNavigator 客户端上显示过程画面 (页 33)

管理 WebNavigator 客户端的用户 (页 13)

发布过程画面 (页 7)

1.5.3 在 WebNavigator 客户端上显示过程画面

简介 

您要在 WebNavigator 客户端上显示新的过程画面，请针对此示例使用 "WinCCViewerRT" 
Web 查看器。

要求

● 已安装 WebNavigator 服务器和“WinCC WebNavigator”许可证。

● 已在 WinCC 中创建了用户。

● 已在 WinCC 中创建了过程画面。

● 过程画面已发布，并且已指定为用户的起始画面。

● WinCC 项目已运行。

● 已组态 WinCCViewerRT。

步骤

1. 从 Windows“开始”(Start) 菜单选择“开始 > 程序 > Siemens 自动化 > 选项和工具 > HMI 工
具 > WinCCViewerRT”(Start > Programs > Siemens Automation > Option and Tools > HMI 
Tools > WinCCViewerRT) 命令。

2. 登录到 WebNavigator 服务器：

– 如果已在 "WinCCViewerRT" 组态对话框中设置了用户名和密码，则不会显示登录对

话框。 会使用存储的登录数据自动登录。

– 如果未在 "WinCCViewerRT" 组态对话框中设置用户名和密码，则会显示登录对话

框。

在“常规”(General) 选项卡中输入用户名和密码。单击“确定”(OK)。

3. 可以使用预设的默认组合键 <Ctrl+Alt+P> 来更改用户。 "WinCCViewerRT" 组态对话框随即
打开。
在“常规”(General) 选项卡中输入用户名和密码。单击“确定”(OK)。
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结果

将在 "WinCCViewerRT" Web 查看器中显示趋势窗口。 趋势值已从归档加载。

参见

组态 WinCCViewerRT (页 24)

打开 WinCC 项目 (页 27)
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WinCC/WebNavigator 文档 2
2.1 功能概述

简介             

WinCC/WebNavigator 为操作员通过 Intranet 或 Internet 监控自动化系统提供了解决方案。

WinCC/WebNavigator 提供了简单有效的方法来实现 WinCC 项目的操作员监控功能。

其支持最新的 Internet 安全方法。使用 SSL 加密来提高 Internet 安全性。

可选的“WinCC/WebNavigator”包由以下组件组成： 

● WebNavigator 服务器

● WebNavigator 客户端

● WebNavigator 诊断客户端

WebNavigator 服务器

所有在 WebNavigator 客户端上显示的必要 WinCC 画面和功能都存储在 WebNavigator 服
务器上。Web View Publisher 将自动地对 Web 所需的项目数据进行必要的调整。以此确

保最佳性能。

WebNavigator 服务器需要 Microsoft Internet 信息服务 (IIS) 来与 WebNavigator 客户端通

信。使用 WinCC Web Configurator 来设置并管理 IIS。

“负载平衡”功能将允许按照各自的服务器授权，将 WebNavigator 客户端均匀分配给不

同的 WebNavigator 服务器。

WebNavigator 客户端

通过启用了 ActiveX 控件的 Internet Explorer 启动 WebNavigator 客户端。如此无需在计

算机上安装整个 WinCC 基本系统，便可操作和监视当前的 WinCC 项目。

通过用户管理控制对 WebNavigator 客户端的访问权限。可为每个用户选择不同的起始画

面和语言。可通过分配用户权限，控制各用户对不同项目区域和功能的访问权限。 

“WinCCViewerRT”Web 查看器程序只用于 Web 项目的可视化。此程序可代替 Internet 
Explorer 使用，以查看 WinCC 项目。
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WebNavigator 诊断客户端

WebNavigator 诊断客户端尤其适合用于以下活动：

● 多个无人照看 WinCC 工作站的远程诊断和操作员控制。

● 使用一台诊断客户端监视多台 WebNavigator 服务器的集中远程维护。

● 需确保可随时访问服务器的超级用户。 

此诊断客户端的功能与 WebNavigator 客户端的功能并无不同。但是，诊断客户端可确保

能随时访问 WebNavigator 服务器。其访问与已登录 WebNavigator 服务器的用户数量无

关。

诊断客户端许可证为您提供了节省成本的解决方案，方便您通过一台或少数几台 
WebNavigator 客户端访问许多 WebNavigator 服务器。您可组合使用 WebNavigator 和诊

断许可证。
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2.2 WinCC/WebNavigator 的可能用途

2.2.1 WinCC 服务器上的 WebNavigator 服务器

通过 Intranet/LAN 链接 WebNavigator 客户端和 WinCC 项目         

WinCC 服务器和 Web Navigator 的服务器组件安装在同一台计算机上。 在独立的解决方

案中，WebNavigator 客户端通过 Intranet/LAN 操作和/或监视当前服务器项目。

此节约成本的解决方案允许出于监视或维护等目的来建立计算机站。 无须在这些计算机上

安装完整的 WinCC 系统。

通过 Internet 和 Intranet 链接 WebNavigator 客户端和 WinCC 项目

WinCC 服务器和 Web Navigator 的服务器组件安装在同一台计算机上。 WebNavigator 客
户端可以通过 Internet 和 Intranet 操作和/或监视当前服务器项目。

部署两道防火墙以保护其免遭来自 Internet 的恶意攻击。 第一道防火墙保护 WebNavigator 
服务器免遭来自 Internet 的攻击。 第二道防火墙为 Intranet 提供了额外的安全性。
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2.2.2 分离 WinCC 服务器和 WebNavigator 服务器

通过通道进行通信             

一组自动化系统被分配给 WinCC 服务器。 项目包括诸如程序、组态数据和其它设置等所

有数据。 在包含 WinCC 和 WinCC WebNavigator 服务器的计算机上，WinCC 项目按 1:1 
的比例建立镜象，不与自动化系统联网。

数据通过 OPC 通道进行同步。 为此，WinCC WebNavigator 服务器需要一个与 OPC 变
量数对应的许可证。

部署两道防火墙以保护系统免受未经授权的访问。 第一道防火墙保护 WebNavigator 服务

器免遭来自 Internet 的攻击。 第二道防火墙为 Intranet 提供了额外的安全性。

WinCC/WebNavigator 文档

2.2 WinCC/WebNavigator 的可能用途

WinCC/WebNavigator
38 系统手册, 02/2017



WinCC/WebNavigator 文档

2.2 WinCC/WebNavigator 的可能用途

WinCC/WebNavigator
系统手册, 02/2017 39



通过过程总线进行通信

在包含 WinCC 和 WinCC WebNavigator 服务器的计算机上，WinCC 项目按 1:1 的比例建

立镜象。数据通过过程总线进行同步。部署两道防火墙以保护系统免遭未经授权的访问。

2.2.3 专用的 Web 服务器

简介       

在大型系统中向 WebNavigator 客户端集中提供数据时，安装专用的 Web 服务器会发挥明

显作用。 专用 Web 服务器处理和优化对客户端的访问，并可用作客户端的 WinCC 服务器

代理。 
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通过在 WinCC 客户端上安装 WebNavigator 服务器，可发挥专用 Web 服务器的功能。

使用专用 Web 服务器的优势

● 可以将负载分散到多个专用 Web 服务器中，以提高整个系统的性能。

● 将专用 Web 服务器和 WinCC 服务器物理分隔在不同计算机上增加了安全性。

● 在不同站点上操作服务器也便于运营职能的分离，例如工厂支持和 IT 部门。

● 专用 Web 服务器能够实现同时访问多个下位 WinCC 服务器。 登录到专用 Web 服务器

的用户无需分别登录到每个项目，即可访问多个 WinCC 项目。

● 专用 Web 服务器支持在两台使用 WinCC 冗余的下位 WinCC 服务器之间进行冗余切

换。
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2.2.4 WinCCViewerRT

概述

在 WebNavigator 客户端上运行“WinCCViewerRT.exe”应用程序而不是 Internet 
Explorer。WinCCViewerRT 随 WebNavigator 客户端一同安装。

使用 WinCCViewerRT 就不需要浏览器。从而可保护系统免受病毒或木马的攻击。

该查看器只显示您已为 Web 访问组态并在 WebNavigator 服务器上发布的画面。根据分配

的权限，用户可以操作或监视项目。在 WinCC 中分配权限 1002“Web 访问 - 仅监视”的

用户只可监视项目。因此，WebNavigator 客户端即所谓的“仅查看客户端”。 

“仅查看光标”表示不能执行过程相关的操作。但某些操作仍然可以执行，如打开 WinCC 
OnlineTrendControl 的属性对话框。 

您也可将 WinCCViewerRT 用作终端服务应用程序。有关更多信息，请参阅“组态 
WebNavigator 服务器的终端服务”。

参见

组态 WebNavigator 的终端服务 (页 104)

2.2.5 WebNavigator 诊断客户端

概述         

WebNavigator 诊断客户端提供了经济实惠的途径来访问多台 WebNavigator 服务器。可同

时使用多个诊断客户端和标准客户端。

许可

此过程不需要更多的 WebNavigator 服务器许可证。在诊断客户端上处理许可事宜。

无论是否达到同时登录 WebNavigator 服务器的最大数量，诊断客户端总能访问 
WebNavigator 服务器。诊断客户端对 WebNavigator 服务器的访问总是有保障。

应用

可能的应用包括：

● 远程维护：诊断客户端用于连续访问不同的 WinCC 系统以提供服务与执行维护。

● 集中维护：诊断客户端用于同时访问多台服务器。
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2.2.6 终端服务与 WebNavigator

简介           

通过 Windows 服务器操作系统的终端服务可访问 Windows 服务器的桌面。 应用程序（例

如 WinCCViewerRT）在终端服务器上激活期间，由终端客户端提供屏幕输出。

终端服务仅将应用程序的用户界面传送到客户端。 每个客户端的键盘输入和鼠标操作都被

返回服务器。

关于具有终端服务的冗余系统组态，请参见相应的 Microsoft 文档。

终端服务的优点

● 客户端可以采用内存要求低的耐用硬件，例如，适用于多尘环境且无需风扇和硬盘。

● 采用仅需有限能耗的移动客户端，如手持设备、掌上电脑或 PDA。

● 所有应用程序均位于安全环境中的服务器上。

● 简易集中的管理和系统维护。

● 支持不同操作系统，例如 Windows CE、Windows 95。
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2.3 组态 WebNavigator 系统

2.3.1 组态步骤概述

先决条件    

● 服务器和客户端通过 TCP/IP 互连。

● 在服务器上

– 已安装 Internet 信息服务。

– 已安装 WebNavigator 服务器。

– 已安装许可证密钥。

– 已安装 WinCC。

● 在客户端上

– 已经安装 Internet Explorer。
或

– 已安装 WinCCViewerRT。

基本操作步骤

必须完成以下组态方可设置 WebNavigator 系统：

1. WinCC 项目的组态。

– 发布用于 Web 访问的 WinCC 过程画面

– 组态 Web 设置

– 创建并管理用户对 WebNavigator 客户端的访问。

2. WebNavigator 服务器的组态。

– 组态 WebNavigator 网页。

– 如有必要，组态 "Load Balancing" 功能。

3. 考虑与 WinCC 基本系统的差异以及相关限制。
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2.3.2 组态 WinCC 项目

2.3.2.1 发布 WinCC 过程画面

发布 WinCC 过程画面

简介                 

如果要在 WebNavigator 客户端或 DataMonitor 客户端上显示 WinCC 过程画面，则须发布

画面。若要发布，可使用 Web View Publisher，它会自动对项目数据进行必要调整。 

概述

Web View Publisher 允许以下发布类型： 

● 在本地计算机上发布。

当前 WinCC 项目文件夹是源文件夹。

目标文件夹是子文件夹，例如，“Projectname/WebNavigator/Pictures”。

● 通过服务器前缀在专用 Web 服务器上发布。

源文件夹是在另一台 WinCC 计算机上的 WinCC 项目文件夹，此计算机通过服务器前

缀定义。

目标文件夹位于 WinCC 客户端上的 WinCC 项目子文件夹“.../WebNavigator/Pictures”
中。自己的项目画面会以“<picturename>.PD_”名称保存，而其它项目的画面则会

以“<serverprefix>_ _<picturename>.PD_”名称保存。

● 远程发布。

源文件夹和目标文件夹可以位于相同或不同 Web 服务器上。

您可以在带有源文件夹或目标文件夹的 Web 服务器上或在第三台 Web 服务器上启动 
Web View Publisher。

● 在专用 web 服务器或在 WinCC 客户端上从不同的远程站进行远程发布。

WinCC 项目的项目文件夹必须在专用的 web 服务器/WinCC 客户端上的 Windows 中发

布。您可以在远程计算机上通过打开 web 服务器/WinCC 客户端的 WinCC 项目来远程

启动 Web View Publisher。在远程站，从其它 WinCC 服务器向专用 web 服务器发布 
WinCC 画面。

Web View Publisher 执行以下调整：

● 数据压缩，从而优化 Internet 的性能。

● 删除操作所不需要的项目特定数据。
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● 画面窗口转换到 ActiveX 组件。

● 转换脚本使之能在客户端上运行。

在 Internet Explorer 中打开发布的画面

要直接打开发布的画面，必须已建立网站。

1. 在 WinCC 项目管理器的 WebNavigator 表格区中，选择一个已发布画面。

2. 从快捷菜单中选择“将 URL 复制到剪贴板”(Copy URL to clipboard) 命令。

3. 将剪贴板中的链接粘贴到 Internet Explorer 的地址栏。

包含相关画面的文件将在 Internet Explorer 中打开。

带有错误脚本的画面发布

如果在发布期间生成警告或错误，受影响的过程画面将被标记在 Web 发布向导的输出字段

中。尽管如此，脚本中带有错误的画面仍会被发布。然而，运行系统中仍可能发生错误，

并且 WebNavigator 客户端会报告错误。 

可在 Web View Publisher 中直接启动“PdlPad”工具，以便检查和更正（如有需要）所发

布画面中使用的脚本。

不带项目函数发布

不带有项目函数的发布可能是另一种错误来源。当使用 Web View Publisher 进行发布时，

将始终发布所选择的项目函数。如果发布时不带有项目函数，画面将不再包含任何项目函

数。上一次发布过程中的项目函数始终可供所发布的画面使用，从而也可在客户端上使

用。 

发布器中项目函数的选择与同一过程中所发布的画面无关。例如，如果修改了选择的项目

函数，但没有修改其界面，则需要发布所有必需的项目函数。这种情况下，不必发布画面。

在图形编辑器中更改过程画面

在 WebNavigator 服务器上，对于运行系统中在图形编辑器中编辑的过程画面，必须再发

布一次。过程画面需要显示在 WebNavigator 客户端上。

当使用专用 Web 服务器时，从远程站的服务器上打开 WinCC 项目，从而将更改传送到 
WebNavigator 客户端。完成后，在图形编辑器中打开和保存修改的画面。下一步，在专

用 web 服务器上使用 Web View Publisher 发布画面。 

如果已经修改大量画面，则可以简化这个过程。为此，在图形编辑器快捷菜单中调用“转

换画面”功能。完成后，必须再次发布画面。
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参见

如何使用 Web View Publisher 发布 WinCC 过程画面 (页 48)

发布画面的要求 (页 47)

发布画面的要求

常规要求             

● 画面名不得包含双下划线，如 "__furnace_overview.pdl"。双下划线之前的字符串将被

解释为服务器前缀。

● 软件包名称和/或符号计算机名称中不能包含任何双下划线。

● 软件包名称和/或符号计算机名称不能以下划线结束。

● 此外，如果使用“基本过程控制”，则名称不能以单下划线开始。使用画面树时，更高

级别画面的名称字符串将有一个 "@PTN_" 前缀。有了前导下划线，画面名称将变为拥

有双下划线。

● 如果 WinCC 的安装路径和项目路径中存在两个具有相同名称的头文件，则 Web View 
Publisher 将使用安装路径中的头文件。

专用 web 服务器上的发布要求

● Web Navigator 服务器已安装在 WinCC 客户端上。

● WinCC 客户端具有访问权限的所有 WinCC 服务器的 C 脚本和 VB 脚本都已被复制到 
WinCC 客户端上。

● WinCC 客户端已加载 WinCC 客户端可以访问的 WinCC 服务器数据包。

● 如果想要发布其它计算机上的项目，启动 Web View Publisher 前必须通过网络驱动器

链接这些计算机。此步骤可使您的项目显示在发布器的选择对话框中。您无法直接输入

路径。
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远程发布的要求

● 针对 Web View Publisher 已启用对目标文件夹和源文件夹的访问权限。

WinCC 默认会组态这些 Windows 启用项目。验证这些启用项目不受限制，例如，只对

特定用户有效。

● 如果想要发布其它计算机上的项目，启动 Web View Publisher 前必须通过网络驱动器

链接这些计算机。此步骤可使您的项目显示在发布器的选择对话框中。您无法直接输入

路径。

参见

发布 WinCC 过程画面 (页 45)

如何使用 Web View Publisher 发布 WinCC 过程画面 (页 48)

如何使用 Web View Publisher 发布 WinCC 过程画面

简介                       

使用 Web View Publisher 发布在“图形编辑器”中创建的过程画面。 WinCC Web 发布向

导会帮助您完成发布过程。 
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步骤

1. 在 WinCC 项目管理器的浏览窗口中，选择 "Web Navigator"。
在快捷菜单中选择 "Web View Publisher" 命令。
WinCC Web 发布向导随即启动。

2. 单击“下一步”(Next)。
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3. 如果要在专用的 Web 服务器上发布画面，则激活“服务器前缀”(Server prefix) 选项。
从选择列表中选择包含 WinCC 项目的 WinCC 服务器的前缀。 该列表显示数据包被装载
到 WinCC 客户端的服务器的前缀。
从选择中删除前缀会改变在下面字段中所显示的路径。

4. 在“WinCC 项目的路径”(Path to your WinCC project) 下，选择包含要发布的画面的 WinCC 
项目文件夹。
要在专用 Web 服务器上发布，文件夹应采用下列格式：
"\\<servername>\<serverprefix>_ _<projectname>".
如果想通过远程工作站发布，则需选择包含画面的源项目。
源项目按其在其它 WinCC 服务器上的启用名称显示。
文件夹采用下列格式：
“\\<计算机名称>\<启用名称>”。
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5. 在“WinCC Web 的发布文件夹”(Publishing folder of the WinCC web) 中，选择已发布画面的
目标文件夹。
接受 WinCC 项目文件夹中推荐的文件夹。
不要更改路径规定，除非要传送画面，例如要将画面传送至不同项目。 在这种情况下，前
缀选择列表将会相应地扩展。
验证远程发布过程中发布画面所保存到的指定目标项目。   
选择源项目时路径定义将会被更新。
如果目标项目要位于另一台 WinCC 服务器上，则选择相应的项目。

6. 选择“显示隐藏对象”(Display hidden objects) 选项以在结果列表中显示已自动发布的隐藏
对象。

7. 单击“下一步”(Next)。 将要发布的画面移至“所选文件”(Selected files) 列表。
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8. 单击“下一步”(Next)。 将已发布画面中使用的 C 项目函数移至“所选文件”(Selected files) 
列表。 无法发布单个 VB 脚本。

单击“下一步”(Next)。 
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9. 将要发布的引用图形移至“所选文件”(Selected files) 列表。 引用文件位于“GraCS”文件夹
或“GraCS”的子文件夹中。

单击“下一步”(Next)。 

10.单击“退出”(Exit) 开始发布画面。
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结果

您已成功发布了画面和函数。 结果列表显示已发布对象的状态。 可以单击某个对象来查看

其它对象信息。

利用“<项目文件夹>\WebNavigator\WizardLog.txt”文件可跟踪发布。
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使用 "PdlPad" 检查脚本

"WizardLog.txt" 日志文件包含所用脚本中的错误信息。 还可以使用 "PdlPad" 调试程序查

找错误。 

1. 在 Web View Publisher 的结果列表中双击受影响的对象，打开 "PdlPad"。 将显示发布画面
的脚本。

2. 单击  以检查脚本。

3. 可以临时更正并保存脚本。 这些更正只保存在发布的画面中，不保存在 WinCC 项目的过程
画面中。

在 Windows“开始”(Start) 菜单中通过 "SIMATIC > WinCC > WebNavigator-Server" 也可以

打开 "PdlPad"。

参见

发布 WinCC 过程画面 (页 45)

发布画面的要求 (页 47)
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2.3.2.2 组态 Web 设置

组态运行设置

简介         

可在“WinCC web 设置”(WinCC web settings) 对话框中，组态运行时的行为。

步骤

1. 在 WinCC 项目管理器的浏览窗口中选择“WebNavigator”。 从快捷菜单中选择“Web 设置”
(Web settings) 命令。

2. 切换到“WinCC Web 设置”(WinCC web settings) 对话框中的“运行系统”(Runtime) 选项卡。
选择所需的设置。 单击“确定”(OK) 关闭对话框。
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使用“WinCC 经典”设计

选择此选项来提高 WebNavigator 客户端的性能。 随即会使用 WinCC V6 的原始样式。

“仅监视”光标

默认光标表示不允许 WebNavigator 客户端的用户操作运行系统。 在 WinCC 用户管理器

中，已为该用户分配了 1002 号系统权限 -“Web 访问 - 仅监视”。

如果您要使用自己的光标，请输入其路径和文件名称。 您也可选择“...”按钮来浏览到所选

光标的文件。

最大并发连接数

指定 WebNavigator 服务器的最大负载。 指定同时访问服务器的最大连接数。 计数中包括

已组态的小工具的数量。

同时连接数可以超过 WebNavigator 许可证数，例如，在浏览器窗口中打开了多个选项卡。 
限制到“50”是必要的，因为在没有额外负载的正常操作情况下，服务器可确保最多 50 个
连接。 该值一定不可小于实际的 WebNavigator 许可证数量。

每个浏览器的最大选项卡数

为每个浏览器窗口指定最大选项卡数。 一个浏览器窗口中的多个选项卡计为一个 
WebNavigator 许可证。

激活 WinCC 系统消息

“1012400 号”或“1012401 号”系统消息在登录/注销 WebNavigator 客户端时输出并归

档。

启用事件日志消息

在 Windows 事件查看器中记录成功的会话登录或注销。

禁用 SIMATIC Logon 的本地组

WebNavigator 服务器只能被相同域内的组访问。

图形硬件加速功能

在 WebNavigator 客户端上，激活的 Direct2D 表示适用于整个项目。

小工具形式的 WinCC 画面

概述  

小工具是 Windows 边栏的迷你应用程序。 在 WebNavigator 客户端上，可显示小工具中

已发布的 WinCC 过程画面。
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指定小工具的 WinCC 画面。 在运行系统中，WebNavigator 服务器连续生成每个画面的周

期性快照图像“pdlImage.jpg”。 该文件会保存到 "\WinCC\Webnavigator\Server\Web
\image\_gadget" 文件夹。 小工具会以周期性间隔访问该文件并显示当前生成的画面。

以下对象不在小工具中显示：

● 全局脚本诊断窗口

● WinCC 媒体控件

● 移植的项目中已使用 WinCC V7.0 之前的版本安装的 WinCC 控件

说明

显示的画面不可包含任何用户干预动作。 例如，这包括通过功能调用登录对话框或通知

对话框。

您不能操作小工具中显示的画面。 

注意

更新周期短会给 WebNavigator 系统带来高负载

在小工具中显示 AlarmControl 或有大量趋势视图的过程值更新时，请设置足够长的更

新周期。

如果抓取快照时尚未从控制器读取过程值，则小工具显示起始值而不是实际过程值。

先决条件

● Windows 操作系统必须支持小工具的使用。

● 必须在 WebNavigator 服务器上安装 WebNavigator 客户端以启用小工具的组态。
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在 WebNavigator 服务器上组态小工具 

1. 在 WinCC 项目管理器的浏览窗口中选择“WebNavigator”。 从快捷菜单中选择“Web 设置”
(Web settings) 命令。

2. 切换到“WinCC Web 设置”(WinCC web settings) 对话框中的“小工具”(Gadget) 选项卡。

3. 使用“...”按钮选择“名称”(Name) 下已发布的画面。

4. 指定所选画面的运行语言。

5. 定义所选画面在“小工具”中显示的剪辑。 通常过程画面过大，不能在“小工具”中显
示。 请确保剪辑与小工具有相同的宽度和高度，或至少是有相同的宽/高比。 否则小工具中
画面显示将失真或者带黑框。

6. 单击“添加”(Add)。 将画面插入“画面”(Pictures) 列表。 重复步骤 3 到 6 添加其它画面。

7. 从列表中选择要更改语言或剪辑的画面。 修改设置并单击“更改”(Change)。

8. 在“更新周期”(Update cycle) 字段中，指定服务器用于周期性更新在“pdlImage.jpg”中所显
示画面的时间间隔。
在该时间间隔开始时访问新画面。 从控制器读取最新过程值。 在时间间隔的末尾创建快照
并将其存储在“pdlImage.jpg”中。
以下示例显示更新周期为“10 s”的两个过程画面。
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时间 [秒] 图像

10 Process_Picture_1 -> pdlImage.jpg

20 Process_Picture_2 -> pdlImage.jpg

30 Process_Picture_1 -> pdlImage.jpg

40 Process_Picture_2 -> pdlImage.jpg

1. 如果希望小工具显示画面生成的日期和时间，请选择“时间戳”(Time stamp) 选项。

2. 单击“确定”(OK)，关闭对话框。

在 WebNavigator 客户端上显示小工具

WebNavigator 客户端上用于显示 WinCC 画面的预组态小工具存储在安装文件夹的“\WinCC
\Webnavigator\GADGET”中。

要使用 WebNavigator 客户端访问这些小工具，请按以下步骤操作：

1. 双击安装文件夹中“\WinCC\Webnavigator\GADGET”内的“WebNavigator.gadget”。 小工
具安装在 Windows 边栏中。

2. 指定小工具从 WebNavigator 服务器加载画面的更新周期。

3. 输入 WebNavigator 服务器的地址。 “小工具”建立到 WebNavigator 服务器的连接。

4. 如有必要，将“小工具”拖动到桌面上。

兼容性 Web 设置

使用移植项目    

对 V6.2 以前的 WinCC/Web Navigator 中的 C 脚本，存在以下限制。WebNavigator 客户

端上的以下参数和函数仅返回画面名称，而非完整路径和画面名称： 

● 参数“lpszPictureName”

● 函数“GetParentPicture”

● 函数“GetParentPictureWindow”

从 WinCC/WebNavigator V6.2 开始，可根据需要启用绝对寻址来撤消对 WebNavigator 客
户端的这一限制。
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选择执行 C 脚本时的预期响应：

● 画面名称： 默认情况下，将禁用绝对寻址。 函数或参数仅返回画面名称。 与旧版 
WebNavigator 客户端兼容并保留为这些旧版本创建的 C 脚本。

● 画面名称和路径： 绝对画面名称和完整路径一起返回。

此响应与 WinCC 基本系统的响应一致。 不需要修改在 WinCC 基本系统上使用的 C 脚
本以在 WebNavigator 客户端上执行。

程序

1. 在 WinCC 项目管理器的浏览窗口中选择“WebNavigator”。 从快捷菜单中选择“Web 设置”
(Web settings) 命令。

2. 切换到“WinCC Web 设置”(WinCC web settings) 对话框中的“兼容性”(Compatibility) 选项
卡。

3. 激活预期的 C 脚本响应。 

4. 单击“确定”(OK)，关闭对话框。
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2.3.2.3 管理 WebNavigator 客户端的用户

简介                       

将操作员监控权限分配给用户以通过 WebNavigator 客户端访问 WinCC 项目。   可为每个

用户选择起始画面和运行系统语言。 使用“自动注销”功能来指定从 WebNavigator 客户

端访问 WinCC 项目的超时设置。 在该时间过后将自动注销用户。

自动注销

自动注销在 WebNavigator 系统中有以下优点：

● 从 WebNavigator 客户端访问 WinCC 项目受超时的制约。 这样可加强系统安全性，特

别是使用无人照看的客户端访问 WebNavigator 服务器时。

● 自动注销后，客户端使用的许可证将再次释放。

● 自动注销后将降低 WebNavigator 服务器的当前负载。

要求

● 使用 Web View Publisher 发布了 WinCC 过程画面。

● 打开了 WinCC 用户管理器。

● 创建了用户。

● 指定了用户的系统权限。

● 在使用了 WinCC 选项“基本过程控制”(Basic Process Control) 时，指定了域特定权

限。
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步骤 

1. 在浏览窗口中选择所需用户。

2. 该用户的操作权限显示在表格窗口。
如果已启用系统授权“Web 访问 - 仅监视”，则仅允许用户作为 WebNavigator 客户端监视 
WinCC 项目。
如果禁用此系统权限，则分配给用户的其它操作权限有效。 因此，请检查其它权限设置。

3. 根据需要，在用户属性的“注销”(Logout) 字段中指定自动注销前的时间。 要转至属性区域，
请在导航窗口中选择用户组，然后在表格窗口中选择用户。

– 如果输入“无”(None)，则将禁用自动注销。

– 如果选择“绝对”(Absolute) 选项，则从登录时开始计算组态的自动注销时间。 该时

间到期与用户操作无关。

– 如果选择“未激活”(Inactive) 选项，则从用户最后一次键盘或鼠标操作开始计算组态

的时间。 经过这段时间的暂停后，用户将自动注销。

“自动注销： 与服务器断开”消息在自动注销后显示。 可按“F5”刷新页面并重新连接 
WebNavigator 服务器。

4. 在用户属性中，激活“WebNavigator”选项。 
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5. 在“Web 起始画面”(Web start picture) 中，通过下拉列表为用户选择起始画面。只能选择已
发布的画面作为起始画面。  

6. 在“Web 语言”(Web language) 中，通过下拉列表为用户选择运行系统语言。 文本库中创建
的语言可供选择。  

7. 关闭用户管理器。

使用 SIMATIC Logon 时的限制

WebNavigator 服务器支持 SIMATIC Logon。 可是有以下限制：

● 如果用户是多个用户组中的成员，则将随机选择一个组态了起始画面的组。 无法组态要

选择哪个组。 用户所属的所有组的授权都将加以考量。

● 在 Internet Explorer 登录对话框中，给用户名称添加域前缀： “<domain>
\<username>”。

● 客户端会话期间密码过期不影响 WebNavigator 客户端的操作。

● 您只能在 WebNavigator 服务器上更改密码。

● 在 WebNavigator 服务器上使用 SIMATIC Logon 时，WebNavigator 客户端不支持以下

功能：

– 脚本

– ODK 功能

– 用户管理器

2.3.3 组态 WebNavigator 服务器

2.3.3.1 组态 WebNavigator 网页

WinCC Web Configurator

简介                 

WinCC Web Configurator 用于设置和管理 Microsoft Internet 信息服务 (IIS)。 

要求

● 已安装 WebNavigator 服务器。

● 已安装 Windows“Internet 信息服务”组件。
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启动 WinCC Web Configurator

● 在 WinCC 项目管理器的浏览窗口中选择“WebNavigator”。

从快捷菜单中单击“Web Configurator”命令。

● 也可单击桌面上的“Web Configurator”快捷方式。

使用 WinCC Web Configurator 进行首次组态

在首次组态期间，可指定是要创建新默认网页还是新虚拟文件夹。 

如果仅在服务器上操作 Web Navigator 网页，则选择“新建标准网页（独立）”(Create a 
new standard web page (standalone)) 选项。

要将 WebNavigator 网页作为子文件夹添加到现有网页，则选中“添加至现有网页（虚拟

文件夹）”(Add to existing web page (virtual folder)) 复选框。 如果当前的默认网页必须保

持激活状态，或操作系统只支持一个网页运行，则该选项可能是必需的。  

说明

64 位操作系统上的默认网页

如果在一个 64 位操作系统上运行默认网页，则必须在 IIS 管理器的“默认网站”(Default 
Web Site) 高级设置下的“DefaultAppPool”应用程序池中允许使用 32 位应用程序。
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管理 WinCC Web Configurator 中的组态

如果已组态 IIS，则使用 Web Configurator 编辑现有 Web 服务器或虚拟文件夹的设置。

Web Configurator 会自动检测组态是否已存在。 如果找到现有组态，则会打开用于编辑组

态的对话框。

说明

已修改或删除 Web 文件夹

如果已删除 web 文件夹，则在使用 Web Configurator 创建新 Web 文件夹前，请重启计算

机。

请注意以下说明：

● 如果在更改 Web 文件夹后 Web 通信失败，则 Web Configurator 将尝试调整相关设置。

● 如果此操作不成功，请执行以下操作：
1. 退出 IIS 控制台。
2. 要删除 WebNavigator 网页，则在“运行”(Run) 窗口中输入以下命令：
"<wincc_installationpath>\WebNavigator\Server\bin\WinCCWebConfigurator.exe" 
deinstall="yes"。
3. 从 IIS 控制台启动所需网页，例如，标准网页。

创建新默认网页

简介         

可使用 WinCC Web Configurator 创建标准网页。

先决条件

● 已安装 WebNavigator 服务器。

● 已安装 Windows“Internet 信息服务”组件。

● 已启动 WinCC Web Configurator。
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过程

1. 选择“新建标准网页（独立）”(Create a new standard web page (standalone)) 选项，然后
单击“下一步”(Next)。

2. 选择“网页名称”(Name of the web page) 并输入名称。

3. 在“端口”(Port) 字段中输入访问所需使用的端口号。 默认情况下会设置 HTTP 端口“80”。
如果选择其它端口号，则在 WebNavigator 客户端登录时，必须将此端口号追加到 Internet 
Explorer 地址栏中的服务器名称后面，例如 
“http://<servername>:<portnumber>”。

4. 在“IP 地址”(IP address) 中，指定是否可以在 Intranet、Internet 或这两个网络上访问计算
机。
用户只能使用选择列表中提供的地址。 
选择“未分配全部”(All not assigned) 即可通过 Intranet 和 Internet 访问计算机。

5. 选择 Web 服务器后，选择要在 WebNavigator 客户端上显示的默认网页。

– MainControl.asp
打开 WinCC Web Navigation 界面以及在用户管理中指定的起始画面。 例如，需要

通过 Web Navigation 界面下载插件。

– WebClient.asp
打开在用户管理中指定的起始画面。

6. 指定连接失败后自动建立连接的时间间隔。
时间设置为“0”时将禁用“自动重新连接”(Automatic reconnection) 功能。
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7. 指定组态完成后是否启动网页。

8. 如果尚未激活防火墙，则单击“完成”(Finish)。 如果已经安装防火墙，则单击“下一步”
(Next)。

结果

成功创建了 Web 文件夹并激活了网页。 

创建虚拟文件夹

简介     

可使用 WinCC Web Configurator 创建虚拟文件夹。

先决条件

● 已安装 WebNavigator 服务器。

● 已安装 Windows“Internet 信息服务”组件。

● 已启动 WinCC Web Configurator。
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过程

1. 启用“添加至现有的 Web（虚拟文件夹）”(Add to existing web (virtual folder))。单击“下
一步”(Next)。

2. 选择您要添加虚拟文件夹的激活网页。
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3. 单击“确定”关闭对话框。
在下一个对话框中，单击“下一步”(Next)。

4. 选择“网页名称”(Name of the web page) 并输入名称。

5. Web Configurator 应用 IIS 设置作为端口号和 IP 地址。

6. 选择 Web 服务器后，选择要在 WebNavigator 客户端上显示的默认网页。

– MainControl.asp
打开 WinCC Web Navigation 界面以及在用户管理中指定的起始画面。 例如，需要

通过 Web Navigation 界面下载插件。

– WebClient.asp
打开在用户管理中指定的起始画面。

7. 指定连接失败后自动建立连接的时间间隔。
时间设置为“0”时将禁用“自动重新连接”(Automatic reconnection) 功能。

8. 指定组态完成后是否启动网页。

9. 单击“完成”以完成组态。

结果

创建了虚拟 Web 文件夹并激活了网页。 

在 WebNavigator 客户端上，在 URL 中添加虚拟 Web 文件夹名称来访问该网页，例如

“http://WebServer/WebNavigator”。
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无激活的网页

如果没有发现激活的网页，则 Web Configurator 将以消息提示方式终止。

在重新启动 Web Configurator 前激活网页。 有关更多信息，请参见“检查激活的网页”。

参见

检查激活的网页 (页 73)

组态防火墙

简介  

本节将以 Windows 7 和 Windows Server 2008 R2 为例介绍如何为端口“80”激活“HTTP”
和“HTTPS”服务。

如果您想以高级安全性或针对不同端口设置 Windows 防火墙，请咨询您的网络管理员。

要求

● 已经使用 Web Configurator 创建了默认网页。

● 防火墙已激活。

● 登录的用户具有 Windows 管理员权限。

● 如果 WebNavigator 使用 HTTPS 服务，则必须在 IIS 中设置 HTTPS 服务。有关更多

信息，请参见“在 IIS 中设置 HTTPS 服务 (http://support.microsoft.com/kb/
324069)”。

WinCC/WebNavigator 文档

2.3 组态 WebNavigator 系统

WinCC/WebNavigator
系统手册, 02/2017 71

http://support.microsoft.com/kb/324069
http://support.microsoft.com/kb/324069


默认端口的设置步骤

1. 在“WinCC Web Configurator”中，单击“Windows 防火墙”(Windows Firewall)。

“Windows 防火墙”(Windows Firewall) 对话框随即打开。

2. Windows 7：单击“允许程序或功能通过 Windows 防火墙”(Allow a program or feature 
through Windows Firewall)。
Windows Server 2008 R2：单击“允许程序通过 Windows 防火墙通信”(Allow a program to 
communicate through Windows Firewall)。

3. 激活“安全 WWW 服务 (HTTPS)”(Secure WWW services (HTTPS)) 或“WWW 服务 (HTTP)”
(WWW services (HTTP))。

4. 单击“确定”(OK) 关闭所有 Windows 对话框。

5. 在 Web Configurator 中单击“完成”(Finish)。
服务器组态完成。
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检查激活的网页

Windows 7/Windows Server 2008 R2 的操作步骤  

1. 从 Windows 开始菜单选择“所有程序 > 管理 > Internet 信息服务 (IIS) 管理器”(All programs 
> Administration > Internet Information Services (IIS) Manager)。

2. 在“连接”(Connections) 字段中单击计算机名称。

3. 单击“默认 Web 站点”(Default Web Site)。

4. 检查网页视图。
如果在需要的网页（例如“WebNavigator”）旁边显示状态“停止”，则需要启动网页。
从快捷菜单中选择“启动”(Start) 命令以启动网页。

5. 选择“Internet 信息服务 (IIS) 管理器”(Internet Information Services (IIS) Manager)。将激活
网页。

2.3.3.2 使用“装载平衡”功能进行装载分配

WebNavigator 服务器上的负载平衡

概述         

“负载平衡”功能可以将 WebNavigator 客户端自动均匀分配给不同的 WebNavigator 服
务器。所有 WebNavigator 服务器都可以使用各自的服务器许可证参与负载平衡。 
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WebNavigator 服务器可以作为“负载平衡”服务器或仅作为参与的 WebNavigator 服务

器。 

之后相应的 WebNavigator 服务器可按如下所示在“负载平衡组态”(Load Balancing 
Configuration) 对话框中进行组态：

● WebNavigator 服务器仅是一个参与的 WebNavigator 服务器。

● WebNavigator 服务器是负载平衡服务器。 

“负载平衡”服务器也自动成为参与的 WebNavigator 服务器。 

在一组参与的 WebNavigator 服务器内，可组态多个“负载平衡”服务器。 

负载平衡顺序

在登录 WebNavigator 客户端之后，“负载平衡”服务器会将客户端传送到负载最小的参

与 WebNavigator 服务器。 

将使用“LBConfig.xml”文件分配客户端。该文件在“项目文件夹/WebNavigator”中。 

如果登录到“负载平衡”服务器的客户端数目极少，则新的客户端将仍然连接到该服务

器。 

如果参与的 WebNavigator 服务器出现故障，则登录到该服务器的客户端将在 Webserver 
再次可用前，一直显示在“重新连接屏幕”上。 

WebNavigator 服务器的地址与其是否作为“负载平衡”服务器激活无关。 

许可证

“负载平衡”功能最多可支持 32 个 WebNavigator 服务器互连。 
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所有参与的 WebNavigator 服务器和“负载平衡”服务器都需要“负载平衡”许可证。 

WebNavigator 客户端上不需要任何许可证。 

使用具有 WinCC 冗余功能的 WinCC 计算机时，可以使用“WinCC 冗余”许可证和“负载

平衡递升”许可证操作“负载平衡”服务器或参与的 WebNavigator 服务器。 

示例
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图中，WebNavigator 服务器 1 至 3 均参与“负载平衡”。“负载平衡”许可证已安装在 
WebNavigator 服务器上。 

WebNavigator 服务器 1 和 2 被组态为“负载平衡”服务器。 

当 WebNavigator 客户端 1 登录到 WebNavigator 服务器 1 或 2 时，客户端将被自动转送

给负载最小的服务器。

如果所连接的 WebNavigator 服务器出现故障，客户端 1 将被重新发送给其它 WebNavigator 
服务器中的一个。 

WebNavigator 服务器 3 参与了“负载平衡”，但没有组态为“负载平衡”服务器。 

在产生高负载或者服务器 1 或服务器 2 发生故障时，WebNavigator 客户端可以被重新发

送到服务器 3。如果 WebNavigator 服务器 3 发生故障，则无论有何种活动连接，客户端

都无法被重新发送到服务器 1 或 2。

WebNavigator 服务器 4 不参与“负载平衡”。WebNavigator 客户端 2 登录到该服务器时

可能会失败，因为超过了该服务器的负载限制。在 WebNavigator 服务器 4 发生故障时，

无论有何种活动连接，客户端都无法被重新发送到 WebNavigator 服务器 1 到 3 中的一

个。 

使用代理服务器的设置

使用代理服务器可能导致参与 WebNavigator 服务器或“负载平衡”服务器的目标地址

“http://<服务器名称>”被替换为“http://<服务器名称.代理名称>”。 

这样将无法找到 WebNavigator 服务器的地址。因此，必须在涉及的所有其他参与服务器

的 Internet Explorer 中输入服务器的目标地址。在“工具 > Internet 选项 > 连接 > 局域网

设置 > 高级”(Tools > Internet Options > Connections > LAN Settings > Advanced) 的“例

外情况”(Exceptions) 字段中输入地址。 

参见

组态“装载平衡”功能 (页 76)

组态“装载平衡”功能

简介         

在每个参与 WebNavigator 服务器和负载平衡服务器上都需要许可证。 

所有负载平衡服务器和参与 WebNavigator 服务器都包括在负载平衡服务器列表中。 

在所有负载平衡服务器上，所有参与服务器的列出顺序必须相同。 
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设置查询间隔并激活“负载平衡”功能。 

WebNavigator 客户端上不需要组态。

说明

相同的参与 WebNavigator 服务器列表

负载平衡服务器上与所有参与 WebNavigator 服务器上的列表必须完全相同，以确保某台 
WebNavigator 服务器出现故障时功能一致。

移植项目的设置

“负载平衡”设置是针对每个特定项目进行保存的。您需要再次保存该设置以为这移植项

目激活这些设置。启动组态对话框并单击“确定”(OK) 确认设置。

先决条件

● 已安装 WinCC 基本系统、WebNavigator 服务器和“负载平衡”许可证。

● 在所有参与 WebNavigator 服务器和负载平衡服务器上已组态相同的用户。

● 在 WebNavigator 服务器上，WebNavigator 的默认网页必须创建为“独立”形式。
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过程

1. 在 WinCC 项目管理器中，从“WebNavigator”快捷菜单中选择“负载平衡”(Load Balancing) 
命令。“装载平衡组态”对话框打开。

2. 在上方的字段中，输入参与“负载平衡”的 WebNavigator 服务器的地址。单击“添加”(Add) 
以包括服务器列表中的地址。
对每个要参与“负载平衡”的 WebNavigator 服务器重复上述过程。在列表中增加负载平衡
服务器的名称。
始终可从列表中删除服务器名称。从列表中选择名称并单击“删除”(Remove)。

3. 选中“启用负载平衡”(Enable Load Balancing) 复选框，激活本地 WebNavigator 服务器作
为负载平衡服务器。
参与 WebNavigator 服务器上的该复选框仍然为取消激活状态。
甚至清除该复选框时，服务器列表仍然会保留。 

4. 在“轮询间隔”(Polling Interval) 字段中，选择轮询其他参与 WebNavigator 服务器的时间间
隔。时间间隔只与负载平衡服务器有关。

5. 单击“保存”(Save)。

6. 单击“确定”(OK)，关闭对话框。

7. 在所有参与 WebNavigator 服务器和负载平衡服务器上重复该过程。
所作的修改将在重新启动 WinCC 运行系统时生效。
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2.3.4 与 WinCC 基本系统的不同之处

2.3.4.1 功能限制

简介     

与 WinCC 基本系统相比，WebNavigator 有某些功能限制。因此，您应检查您的 WinCC 
项目是否有这些限制并根据需要调整项目设置。

概述

使用项目中不支持的功能时，运行系统中将生成相应的消息以引起您的注意。

WebNavigator 客户端有以下限制：

● 客户端只提供运行中 WinCC 项目的视图。

不能组态 WinCC 服务器项目。

● 除非文档中明确指定，否则不能使用 WinCC 选项和 WinCC 附加软件。

● 并不支持所有的“运行系统 API 函数”。

支持函数的列表可在“支持的函数 (页 110)”中找到。

● 有关与基本过程控制结合使用的限制信息，请参见 WinCC 信息系统中的“过程控制选

项 > 过程控制系统选项概览 > 在 PCS 7 环境中组态 > Web 客户端”(Options for Process 
Control > Overview of process control system options > Configuring in the PCS 7 
environment > Web Client)。

● 消息归档和消息系统只能被操作和监控。 

● WinCC V7 版本之前的 WinCC 控件：无法修改归档和变量选项以实现过程值的可视化。

选择按钮已禁用。

● “WinCC 报警控件”功能不支持消息的“触发动作”属性。

为了正确显示消息块，不能激活“应用项目设置”(Apply project settings) 选项。可

在“WinCC AlarmControl”属性对话框的“消息块”(Message blocks) 选项卡上查找此选

项。

● 不支持在 WinCC 中组态的热键。

支持操作员使用 Tab 键进行控制。

● 不支持 WinCC 共享库的“全局库/操作/操作面板”文件夹中包含的以下对象：

– 1_Slider
– 2_Slider
– 4_Slider
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● 在 Internet 上，不支持过程画面或引用图形名称中使用相关国家的特殊字符。

● 不支持过程画面中的重叠锁定。

● 不能禁用高级缩放功能。如果不想应用缩放功能，请勿在客户端上使用具有“自动滚

动”设置的滚轮鼠标。

● 冗余切换只在专用 Web 服务器上受支持。

参见

使用“硬拷贝”功能 (页 96)

FAQ 21606152 (http://support.automation.siemens.com/WW/view/zh/21606152)

2.3.4.2 使用脚本

专门用于 WebNavigator 的脚本               

要仅为 WebNavigator 执行脚本，请使用脚本中的预处理器定

义“RUN_ON_WEBNAVIGATOR”。例如：
void OnOpenPicture (char* lpszPictureName, char* lpszObjectName, 
char* lpszPropertyName)
{
#ifdef RUN_ON_WEBNAVIGATOR
// 在此处输入仅在 WebNavigator 中执行的代码
#else
// 在此处输入仅在 WinCC 基本系统中执行的代码
#endif
}

Visual Basic 脚本

使用 VBS 时，只有不支持的函数会引起轻微限制。 这些功能的列表可在“不支持的函数 
(页 123)”中找到。

全局脚本

在服务器工程中，组态 WinCC 服务器上的脚本。 

在 WebNavigator 客户端上不能执行全局脚本。 在服务器上支持全局脚本。

使用动态向导生成的脚本不能包含不受支持的函数，因此无法在 WebNavigator 客户端上

执行。 如有必要，检查并更正脚本。 添加以下条件，例如： “#ifdef 
RUN_ON_WEBNAVIGATOR”。 
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带有触发器变量的脚本

WebNavigator 每经过“1 秒”的周期间隔查询一次变量。 触发器变量“有变化时”的更新

周期也是一秒。 

这可能导致 AS 与 WinCC 服务器间的通信负载增加。 如果 AS 与 WinCC 服务器间的通信

达到负载极限，就必须对增加的负载加以考虑。 

如果变量触发的脚本请求其它变量，这些变量的名称需使用字符串函数生成，则只能同步

读取这些未知变量。 输入在触发器列表中使用的变量名称，以避免需要多次进行选择。 

选择画面和取消选择画面的脚本 

与基本系统不同，使用 WebNavigator 时会在异步模式中下载画面。 在使用包含画面更改

的脚本时会出现这一情况。 

如果在脚本中启动对画面窗口的画面选择，则之后不能在相同脚本中访问新画面的对象。 
因为那时尚未加载画面。 时间延迟如“Sleep(2000)”，也不起作用，因为脚本和 Internet 
Explorer 正在等待。 因此，应在“OpenPicture”函数（加载画面后触发）中执行随后的脚

本元素。

取消选择画面后在脚本中调用其它函数时，将导致函数执行出错或根本不执行。 取消选择

画面会导致画面上下文会丢失。

同步脚本函数

同步脚本函数会给系统带来高负荷。 

因此应在周期性脚本中避免使用“SetTagxxx”函数。 当许多客户端以一个很短的周期（例

如，1 秒或更短的时间）调用“SetTagxxx”函数时，将导致服务器过载。

请注意，以下脚本函数和调用将同步传送到服务器：

● 在同步模式下写入变量然后等待结果的函数，例如“xxxWait”

● C-API 调用

频繁使用这些脚本函数和调用将削弱 WebNavigator 客户端的性能。 若使用 Internet 连接，

这些调用的持续时间甚至可能在几秒的范围内。

由于在客户端和服务器之间无数据流量发生，因此操作显示画面中对象的脚本函数无关紧

要。
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画中画方法和周期性脚本 

画面中如果有许多同步调用，可能会削弱性能，例如在以下情况下：

● 在一个画面窗口中组态了十个以上的窗口。

● 在窗口中使用了包含同步调用（例如“SetTagxxx”）的周期性脚本。

某些脚本的执行可能会由于超时而失败。 

在窗口中支持以下元素：

● 包含周期性脚本的 16 个窗口。

● 不包含周期性脚本的 31 个窗口。

2.3.4.3 使用变量

本地计算机变量         

WebNavigator 客户端对本地计算机变量的支持有以下限制：

● 使用专用 Web 服务器时，只有该服务器的本地计算机变量在客户端上可用。 客户端上

的变量不能使用其自身的值。

● 从属 WinCC 服务器的本地计算机变量不能在客户端上拥有其自身的值。

● 本地计算机文本变量的起始值只能包含变量名称中允许的字符。 例如，如果文本变量的

起始值包含冒号，则会导致在客户端上不识别该变量。

● 使用用户归档时，客户端上不支持本地计算机变量，因为用户归档只能识别服务器的本

地变量，不能识别 WebNavigator 客户端的变量。

定义本地画面脚本变量

如果画面特定的数据存储在脚本中，则请勿对 WebNavigator 使用 WinCC 变量。 

读/写脚本中的数据总是会生成到服务器的数据流量。 如此将带来额外的通信负载。 

可按如下方式保存画面特定的数据：

● 组态“隐藏”图形对象以便可将其属性用作画面特定的变量。 在存储的值发生变化时，

即会对对象属性执行操作。

● 例如，已创建隐藏的“静态文本”对象。 “文本”属性用来存储文本，而颜色属性用来

存储颜色。 可使用脚本读/写这些属性，从而不需要经由服务器就能影响画面的状态。
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2.4 打开 WinCC 项目

2.4.1 WebNavigator 客户端的常规属性

连接中断后自动建立连接               

如果 WebNavigator 客户端和 WebNavigator 服务器之间的通信中断，客户端将向用户输

出一条消息。 

客户端将执行自动建立连接操作。 成功建立连接后，可选择 WinCC 项目的启动页面。 指
定尝试在 Web Configurator 中建立连接的时间间隔。 

如果在客户端/服务器通信中使用防火墙或代理服务器，则客户端登录可能会成功，但自动

重新连接可能不起作用。 试图重新连接时，客户端会使用“ICMP Ping”，但该命令可能被

防火墙或代理服务器阻止。 在这种情况下，请禁止客户端使用“ICMP-Ping”来重新建立连

接。 通过“ClientConfig.asp”页面或在 Web Navigation 界面中，在“设置 > WebClient 属
性”(Settings > WebClient Properties) 下可找到“重新连接 > 禁用 ICMP Ping”(Reconnect 
> Deactivate ICMP Ping) 设置。  

地址栏内容

无法解释并且与用户不相关的字符串将显示在 Internet Explorer 的地址栏中。 例如，可能

会出现“loadbalancing=no”条目，但该条目不代表参加负载平衡的服务器的状态指示。 

登录时在地址栏中输入字符并且检查服务器名称和端口。

通过在 Internet Explorer 中直接输入进行登录

Internet Explorer 的 Microsoft 安全补丁现在会阻止 WebNavigator 客户端通过在地址栏输

入用户名和密码进行登录。

进度栏中的“自动完成”条目和链接

Internet Explorer 地址栏中的条目显示为进度栏中的链接，或作为后续输入的“自动完成”

提示条目。 可是，在 WebNavigator 客户端登录具有负载平衡功能的 WebNavigator 服务

器时，必须通过验证才能使用这些功能。 

客户端首次登录使用负载平衡功能的服务器时，会被重定向到另一台服务器。 Internet 
Explorer 在进度栏中显示该服务器的地址或将其显示为“自动完成”条目。 在客户端下次

登录时，将应用进度栏中的这一链接或“自动完成”条目而无需验证。 客户端随后会登录

到该服务器。
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具有多个超级用户的 WebNavigator 客户端

若某超级用户在计算机上安装了一个新的 WebNavigator 客户端版本，则此计算机的所有

其他超级用户也必须升级到这个新版本。

超级用户使用不一致的版本可能会出现问题。

这同样适用于超级用户连接到使用旧版 WebNavigator 的服务器的情况。

运行系统中的持续性

画面和对象的持续性数据总是存储在 WebNavigator 客户端上。 在使用有多个项目的服务

器，且这些项目又包含同名画面或对象时，应遵守以下几点说明：

如果在运行系统中为项目画面指定持续性设置，则该持续性设置也会应用于其它项目中的

同名画面。

在专用 Web 服务器上为服务器画面定义了持续性设置后，这些设置将应用于相应的 
WebNavigator 客户端。

WinCC 控件的持续性

在 WinCC V7 或更高版本的控件中，在“在线组态”(Online Configuration) 选项卡的控件属

性中重设相关设置。

适用于 WinCC V7 之前控件的持续性文件位于 WebNavigator 客户端上的“Documents and 
Settings/User/Application Data/Siemens/SIEMENS.WINCC/WebNavigator/Client”文件

夹中。 

可通过以下方式撤消已激活运行系统持续性的控件中的设置：

● 重新设置控件中的各个设置。

● 删除文件。

文本库中的文本变化

如果在运行系统中更改文本库中的文本，则 WebNavigator 客户端不会自动检测此变化。 
为了刷新显示的画面，请在 Internet Explorer 中使用“刷新”图标或“F5”键来重新加载画

面。

作为文本引用的与语言相关的文本

通过文本引用获得的与语言相关的文本在 WebNavigator 客户端上以当前在“用户管理器”

编辑器中为客户端设置的语言显示。
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WinCC 滚动条控件

使用 WinCC 滚动条控件时，将“Continuous_Update”属性设置为“否”(No)。 如果将此属

性设置为“是”(Yes)，则即便最微小的位置变化，也会生成一个事件触发器。 此设置会在 
WebNavigator 客户端上引发高通信负载。

删除 ProTool/Pro 软件

如果删除 WebNavigator 客户端上的 ProTool/Pro 软件，则会注销 HMI 符号库的控件。 要
恢复对这些控件的访问，请重新安装 WebNavigator 客户端。

从 WebNavigator 客户端访问 WinCC flexible Sm@rt 服务器

WebNavigator 客户端可使用 Web Navigation 界面调用“更改服务器”功能以访问 WinCC 
flexible Sm@rt 服务器。 

2.4.2 WebNavigator 客户端上的过程画面

专用 Web 服务器中的画面更改 

如果在专用 Web 服务器上加载了带有服务器前缀的某个画面，则随后将不能显示本地 
WinCC 项目中的不带服务器前缀的任何画面。 

要显示本地客户端项目的画面，请使用服务器前缀“@local”来寻址，例如

“@local::picture123.pdl”。 

OpenPicture() 函数执行时将打开该专用 Web 服务器中的执行对象的上级画面。

画面中的项目功能

首次选择项目时，将在加载起始画面后加载项目功能。 

为此，在首次显示起始画面与执行操作员动作之间可能会有延迟。 尽管已显示画面，但在

大约 1 秒的延迟结束前不能进行操作。 

WebNavigator 客户端上的画面窗口

重命名画面窗口中的画面后，在 WebNavigator 客户端上将多次执行画面窗口的“对象更

改”事件。 

该事件在 WinCC 基本系统上只执行一次。 
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客户端的这一响应与系统相关，因为 Internet 连接采用异步操作原理，可能触发画面窗口

对象的多次更新。 此响应没有什么功能上的含义。

WebNavigator 客户端上的 WinCC web 浏览器 OCX

● 在 Internet Explorer 的 Internet 选项中的“安全”(Security) 选项卡中，必须激活“允许 
ActiveX 控件”(Allow ActiveX controls) 复选框。

● 如果在 WebNavigator 客户端上使用 WinCC Web 浏览器选择过程画面中的一个链接，

则在首次显示链接的页面期间，“返回”(Back) 按钮将失效。 在第二次调用此页面前，

此功能不会正确执行。 更改过程画面后，仍存在此问题。

● WinCC Web 浏览器用于显示过程画面中的静态 Web 内容或 CHM 文档。 不支持带脚

本功能的内容。

● 如果要在 WinCC web 浏览器中禁用鼠标右键以防止 WinCC 客户端访问快捷菜单，请

执行以下操作：

– 使用 Microsoft "Group Policy Object Editor" (Gpedit.msc)。
– 选择路径 "\Windows Components\Internet Explorer\Browser menus" 并将快捷菜单

设置为 "Disabled"。

使用 WinCC UserArchiveControl 时的性能         

更改用户归档会触发已显示的 WinCC UserArchiveControl 进行更新。 下列因素会影响 
WebNavigator 客户端上具有 WinCC UserArchiveControls 的过程画面的性能：

● 将同时访问用户归档的 WinCC UserArchiveControls 数量减到最小。

● 请勿在用户归档中组态超出必要数量的周期性更改。
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2.4.3 使用 Internet Explorer 操作 WinCC 项目

2.4.3.1 使用 Internet Explorer 操作 WinCC 项目

先决条件     

● 在服务器上

– 已安装 WebNavigator 服务器。

– 已安装“WinCC WebNavigator”许可证。

– 已组态和发布 WinCC 画面用于 Web 访问。

– 已在 WinCC 用户管理器中创建 WebNavigator 客户端的用户。

– 已为用户管理器中的该用户指定了起始画面。

– WinCC 项目已运行。

● 在客户端上

– 已安装 WebNavigator 客户端。

– 已经安装 Internet Explorer。

步骤

1. 转到 Internet Explorer 的地址栏并输入 WebNavigator 服务器的地址“http://www.<服务器名
称>”。

2. 确认输入。

3. 键入用户名和密码。 确认输入。

说明

密码区分大小写。

结果

显示默认网页。 视图取决于组态：

● 如果默认网页采用“WebClient.asp”设置，则 WebNavigator 客户端启动时显示为用户

指定的起始画面。

● 如果默认网页采用“MainControl.asp”设置，则 WebNavigator 客户端启动时显示为用

户指定的起始画面和 WinCC Web Navigation 界面。

参见

管理 WebNavigator 客户端的用户 (页 62)
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2.4.3.2 使用 WinCC Web Navigation 界面

WinCC Web Navigation 界面的菜单   

当“MainControl.asp”组态为默认网页时，除起始画面外，WebNavigator 客户端还会显

示 WinCC Web Navigation 界面。

Web Navigation 界面在其菜单中提供了不同的 Web 功能组：

● “更改服务器”： 切换到其它 WebNavigator 服务器。

● “已使用服务器”： 浏览到之前使用的 Web 服务器。
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● “<当前服务器的名称>”（例如“MyProject”或“localhost”）：

– 过程画面： 当前 WebNavigator 服务器的显示或画面。

– 诊断： “Status.html”用于诊断 WinCC 项目和至 WebNavigator 服务器的连接。

– 附加工具： 可由用户自行扩展，例如“DataMonitor”。

– 下载区域： WebNavigator 的扩展和使用 WinCC Plug-In Builder 创建的插件。

这些插件在 WebNavigator 服务器上安装文件夹中的“WebNavigator/Server/Web/
Install/Custom”下。

● “设置”： WebNavigator 客户端的设置，例如过程画面的大小或激活屏幕键盘。 指定

打印机，在 WinCC 控件中使用组态的打印作业执行打印。

● “当前”： 与 Web 页面的链接，例如“SIMATIC HMI”、“WinCC”或“WinCC 
flexible”。

● “语言”： WinCC Web Navigation 界面的语言更改功能。

默认情况下有五种语言可用。 可在“Menu.xml”文件中自定义语言选项。 
这些语言以 CSV 文件格式存储在 WebNavigator 服务器上的“_languages / 
<language_identifier>”子文件夹中。 要添加语言，请引用“mainControl.asp”文件中

的语言文件。

2.4.3.3 扩展 WinCC Web Navigation 界面

简介   

Web Navigation 界面的菜单可以通过附加的条目和功能来扩展。 

在 XML 文件中组态扩展项。 该文件保存在 WebNavigator 服务器的“_custom_data”子文

件夹中。 可为任意命名该文件，因为所有具有“XML”扩展名的文件都在此文件夹中进行

处理。

示例

以下示例将“My Private Menu”子菜单添加到“Server”菜单。 子菜单包含“My 
Link”、“Relative Link”和“Run Script”三个条目。

代码 描述

<?xml version="1.0"?> 版本信息

<menu hook-on="server"> “菜单勾连”命令用来引用在 Web Navigation 界面

上定义“Current Server”菜单的名称“server”。

<caption><lng>My Private Menu</lng></caption> 定义空条目。
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代码 描述

<command>
<caption>My Link</caption>
<open-url target="right">http://www.msdn.com</
open-url>
</command>

用直接链接定义“My Link”条目。

<command>
<caption>Relative Link</caption>
<open-url target="right">project.asp</open-url>
</command>

用相对链接定义“Relative Link”条目。

<command>
<caption>Run Script</caption>
<run-script>alert("Hallo !")</run-script>
</command>

定义用于启动脚本的“Run Script”条目。

</menu> 菜单结束。

2.4.3.4 用“Status.html”诊断连接

简介

“Status.html”页用于诊断 WinCC WebNavigator 服务器及其连接的运行中客户端。  

概述

按如下方式调用诊断页面：

● 如果将 WebNavigator 组态为默认网页，则在 Internet Explorer 中输入地址“http://
<servername>/status.html”。

● 如果将 WebNavigator 组态为虚拟网页，则在 Internet Explorer 中输入地址“http://
<servername>/<foldername>/status.html”。

● 如果通过“MainControl.asp”提供浏览界面，则可从“诊断”(Diagnostics) 菜单中选

择“状态”(Status) 命令。

只有在用户管理器中创建的用户可以访问该页面。
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与 WebNavigator 服务器相关的诊断信息结构

字段 描述

服务器版本 WebNavigator 服务器版本

服务器文件日期 服务器版本的日期

许可证计数 WebNavigator 服务器上的许可证数量

运行系统模式 WinCC Runtime 的状态

上次更新 上次显示刷新的日期和时间。

连接的 WebNavigator 客户端 连接的 WebNavigator 客户端数目

连接的诊断客户端 连接的诊断客户端数目

连接的 DataMonitor 客户端 连接的 DataMonitor 客户端数目
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与连接的客户端相关的诊断信息结构

诊断信息以相关客户端的名称开头。

字段 描述

登录用户 连接的客户端数目 

登录 当前用户的登录名

时间 当前用户的登录时间或是最近自动建立连接的时间。 

类型 客户端的类型，例如标准、DataMonitor

PID Web 服务器上与该客户端通信的 WebNavigatorRT.exe 实例的过程 ID。

说明

您可保存显示的状态信息。 为此，可使用 Internet Explorer 中的“另存为”功能，并选

择“（*.txt）”文件类型。 如果已选择了“（*.htm、*.html）”，则所显示的内容将不保

存。 

2.4.4 使用 WinCCViewerRT 操作 WinCC 项目

2.4.4.1 组态 WinCCViewerRT

简介           

WinCCViewerRT 是用于显示 WinCC 项目的程序。用户可以组态 WinCCViewerRT 以与 
WebNavigator 服务器和 Graphics Runtime 一同运行。

要求

● 在服务器上

– 已安装 WebNavigator 服务器。

– 已安装 WinCC/WebNavigator 许可证。

– WinCC 项目已运行。

– 已组态和发布 WinCC 画面用于 Web 访问。

● 在客户端上

– 已安装 WebNavigator 客户端。
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步骤

1. 双击“Webnavigator\Client\bin”安装文件夹中的链接“WinCCViewerRT.exe”。
如果重新组态 WinCCViewerRT，则组态对话框打开。 
如果已设置了 WinCCViewerRT，则 WinCCViewerRT 打开。使用 <Ctrl+Alt+P> 组合键打
开 WinCCViewerRT 的组态对话框。

2. 在“常规”(General) 选项卡中输入登录数据：

– 服务器地址：http://<服务器名称> 或 http://<IP 地址>
– 用户名和密码，如果想为登录对话框指定默认用户。

– 如果启用“应用项目设置”(Apply project settings) 选项，将激活在用户管理器中组态

的用户设置。

3. 在“参数”(Parameters) 选项卡中指定运行系统语言。
如有需要，禁用用户用于切换到其它程序的所有组合键。 
如有必要，可修改预置的用于打开 WinCCViewerRT 组态对话框的 <Ctrl+Alt+P> 组合键。
定义用户可注销而另一个新用户可登录的组合键。如果在“常规”(General) 选项卡中未设置
任何默认用户，只能使用组合键。
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4. 在“Graphics Runtime”选项卡中，指定 WinCC Runtime 属性：
- 起始画面
- 用户定义的菜单和工具栏的组态文件
- 窗口属性
- 不允许的用户操作

5. 在“运行系统”(Runtime) 选项卡中指定附加的用户操作：

● 激活屏幕键盘

● 使用 <Ctrl+Alt+Del> 组合键可通过屏幕键盘切换到任务管理器或操作系统。

● 自动注销设置

● 激活 Direct2D 来加速图像显示。

● 指定打印机，在 WinCC 控件中使用组态的打印作业执行打印。 

单击“确定”(OK) 关闭对话框。

结果

WinCCViewerRT 组态完毕。关闭对话框后便完成到 WebNavigator 服务器的连接的设置。

设置将被保存到 "WinCCViewerRT.xml" 组态文件中。组态文件设置将在下一次启动 
WinCCViewerRT 时使用。WinCCViewerRT 应用 WinCC 中的用户界面语言。

组态文件存储在以下文件夹中，具体取决于操作系统：

● <用户>\AppData\LocalLow\Siemens\SIMATIC.WinCC\WebNavigator\Client

可对文件进行重命名，例如重命名为“User1.xml”。
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还可以通过组合命令行与用户特定的组态文件来启动 WinCCViewerRT，例如 
"WinCCViewerRT.exe User1.xml"。此步骤允许使用不同的组态，具体取决于登录的用

户。 

如果重命名或删除 "WinCCViewerRT.xml"，则启动时会打开 WinCCViewerRT 组态对话

框。重新组态 WinCCViewerRT 或选择其它不同的组态文件。

说明

如果禁用快捷键或隐藏“关闭”(Close) 按钮，则只能通过脚本函数关闭 WinCCViewerRT。
C 脚本编写的函数：DeactivateRTProject；VBScript 编写的函数：HMIRuntime.Stop。

2.4.4.2 打开 WinCC 项目

先决条件       

● 在服务器上

– 已安装 WebNavigator 服务器。

– 已安装“WinCC WebNavigator”许可证。

– WinCC 项目已运行。

– 已组态和发布 WinCC 画面用于 Web 访问。

– 已在 WinCC 中创建了用户。

● 在客户端上

– 已组态 WinCCViewerRT。

步骤

1. 从 Windows“开始”(Start) 菜单选择“程序 > Siemens 自动化 > 选项和工具 > HMI 工具”
(Programs > Siemens Automation > Options and Tools > HMI Tools) 启动 
"WinCCViewerRT" 。

2. 登录到 WebNavigator 服务器：

– 如果已在 "WinCCViewerRT" 组态对话框中预置了用户名和密码，则不会显示登录对

话框。 会使用存储的登录数据自动登录。

– 如果未在 "WinCCViewerRT" 组态对话框中设置用户名和密码，则会显示登录对话

框。 输入 WinCC 用户的用户名和密码。 密码区分大小写。 单击“确定”(OK)。

3. 要更改用户，可使用为 "WinCCViewerRT" 登录/注销指定的组合键。 先前的用户将被注
销。 在登录对话框中输入新 WinCC 用户的用户名和密码。 密码区分大小写。 单击“确定”
(OK)。
只有未设置任何默认用户时才能使用组合键。
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结果

WinCCViewerRT 自动连接到已激活的 WinCC 项目。 将显示为用户组态的起始画面。 

根据分配的权限，用户可以操作或监视项目。 在用户管理中分配系统权限 1002“Web 访
问 - 仅监视”的用户只可监视 WinCC 项目。

“仅查看光标”表示不能执行过程相关的操作。 

某些操作仍然可以执行，如打开 WinCC OnlineTrendControl 的属性对话框。 

如有必要，可使用自己的光标图标作为“仅查看光标”。 有关详细信息，请参见“组态运

行系统设置 (页 56)”。

<F5> 键触发重新选择 WinCCViewerRT。

2.4.5 使用“硬拷贝”功能

简介       

在 WebNavigator 客户端上，当前视图可输出到默认打印机上。

可使用可组态的组合键或脚本来生成截图。 例如，可通过命令行输入组合键的定义或要打

印的屏幕区域。 

启动硬拷贝应用程序

例如，通过命令行输入或用户定义的函数，在 WebNavigator 客户端上启动“PrtScr.exe”
应用程序。 该应用程序存储在“...\Common Files\Siemens\BIN”文件夹中。 

参数只在启动时传送一次。 请用空格分隔参数。 区分大小写。

在编辑参数前请关闭应用程序。 编辑参数然后重新启动应用程序。

以下参数指定打印截图的过程：

参数 功能

没有参数 在 WebNavigator 客户端上不允许。 
请使用“-infinit”作为替代参数。示例： PrtScr.exe –infinit –hotkey="<ALT>+p"

-end 终止激活的 PrtScr.exe 实例。
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参数 功能

-hardcopy 启动 PrtScr.exe。生成当前视图的截图。 硬拷贝功能将等待组合键以输出到打印机。

在 WebNavigator 客户端仅与“infinit”和“hotkey”参数组合使用此参数。

-nomcp 启动 PrtScr.exe。生成截图并打印当前视图。 随后会关闭 PrtScr.exe。

-C= 
left;top;right;bottom 

启动 PrtScr.exe。生成已指定屏幕部分的截图（以像素为单位）并打印当前视图。 随
后会关闭 PrtScr.exe。 “-C=”始终后跟空格。示例： PrtScr.exe -C= 50;50;100;100 

-l 以横向版式打印。 
可向任意参数组合中添加参数。

-infinit 用于在没有 WinCC 的系统上启动 PrtScr.exe 的参数。 该参数必须与“hotkey”组合

使用。 

-hotkey="x" 指定启动输出到打印机的组合键。

允许使用下列字符和组合： 
<ALT>、<SHIFT>、<CTRL> + {0-9、A-Z、0xXX}

用大写字母写入参数。 允许使用 <ALT>、<SHIFT> 和 <CTRL> 组合键，但并非必须。 
可使用十六进制输入“0xXX”指定带有“XX”的“虚拟键码”。 有关“虚拟键码”的

详细信息，请参见 MSDN 库。

示例： 
“CTRL”与 P 键组合： -hotkey="<CTRL>+P"     
打印按钮（“打印屏幕”）： -hotkey="0x2C" 
组合键“ALT”和“Print-Screen”： -hotkey="<ALT>+0x2C" 

参数组合的示例

通过组合键启动硬拷贝功能  

PrtScr.exe –infinit –hotkey="<ALT>+p"

在命令行中输入以下字串：

"C:\Program Files\Common Files\Siemens\BIN
\PrtScr.exe" –infinit –hotkey="<ALT>+p"

启动 PrtScr.exe 并等待输入“<ALT>+p”组合键。 当
您按下该组合键时，当前屏幕视图即打印为截图。

PrtScr.exe –infinit –hotkey="<ALT>+p" –C= 
10;10;100;100

启动 PrtScr.exe 并等待输入“<ALT>+p”组合键。 当
您按下该组合键时，只有定义的屏幕部分（以像素为

单位）打印为截图。
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通过脚本启动硬拷贝功能。  

PrtScr.exe –nomcp 启动 PrtScr.exe。生成截图并打印当前视图。 随后会

关闭 PrtScr.exe。

PrtScr.exe –C= 10;10;100;100 启动 PrtScr.exe。生成已指定屏幕部分的截图（以像

素为单位）并打印当前视图。 随后会关闭 
PrtScr.exe。
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2.5 安装 WinCC Plug-In Builder

2.5.1 WinCC Plug-In Builder 概述

简介             

使用 WebNavigator Plug-In Builder 创建 MSI 安装程序，以便将更多组件下载到 
WebNavigator-Clients，例如，自定义创建的 ActiveX-Controls.。用户可通过 Web 
Navigator 界面下载 Plug-Ins，并且只能在 WebNavigator 环境中使用。

使用 Plug-In Builder 并不需要掌握安装技术知识。 只需要了解安装程序安装并注册的文

件。 

创建的 Plug-In 安装程序为自解压的“EXE”文件。 该文件在 WebNavigator-Server 上的文

件夹中提供，以便可下载到客户端。 

WebNavigator Plug-In 集成到之前安装的 WebNavigator-Client 中并且通过该 Client 卸载。

WinCC Plug-in Builder 的用户界面

从 WinCC-DVD 中安装 WebNavigator Plug-In Builder。 

在“开始”(Start) 菜单中通过 "SIMATIC > WinCC > Web Navigator > Web Navigator Plug-
In Builder" 打开 Plug-In Builder。

Plug-In Builder 显示总览图以及现有 Plug-In 项目的状态。 旧 Plug-Ins 可能需要重新生成。
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● 用于创建 Plug-In 的各种功能在导航区域、菜单命令和工具栏中提供。

● 所有打开的 PlugIn 项目均在项目管理器中列出。

● 在“Information”区域中，可查看所选 PlugIn 项目的项目状态。

● 在 "Installed Software" 区域中，将会看到计算机上已安装或仍需要的 WebNavigator 组
件。 Plug-In 测试和发布功能仅在某些 WebNavigator 组件上可用。  
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2.5.2 如何发布插件

简介   

可以在本地 WebNavigator-Server 上发布 Plug-In。 因此，Plug-In 可提供给所有 Clients 
进行安装。

如果 WebNavigator-Server 和 Plug-In Builder 位于相同的计算机上，可以直接将 Plug-In 
导出到 WebNavigator-Server。 如果 Plug-In Builder 在其它计算机上，必须将 Plug-In 手
动传送到 WebNavigator-Server。

要求

● Plug-In 已成功生成。 

● 发布操作需要使用 WebNavigator-Server。
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步骤

1. 在导航区域，单击“Publish”，或在“Test”中单击“Next”转至此对话框。

2. 单击  或“Publish”按钮。 创建的 Plug-In 存储在 WebNavigator-Server 的如下安装文
件夹中： "WebNavigator/Server/Web/Install/Custom".

3. 您将在 "Publish Plugin" 结果窗口中看到有关发布状态的信息。 单击链接可直接转至存储位
置。

4. 单击菜单命令“File > Close”关闭项目或通过  关闭 Plug-In Builder.
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在 WebNavigator 客户端上安装插件

要将使用 Plug-In Builder 创建的插件安装在 WebNavigator-Client 上，必须具有 Windows 
管理员权限。 Plug-In Builders 和 WebNavigator-Clients 的版本必须相同。

使用 Web Navigator 界面来安装 Plug-In。 在“下载区域/下载插件”(Download Area/
Download plugins) 菜单中，选择所需的 Plug-In。
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2.6 组态 WebNavigator 的终端服务

2.6.1 使用终端服务进行通讯

从 WebNavigator 客户端和 WinCC 客户端访问 WebNavigator 服务器   

当 WebNavigator 客户端通过终端服务和 WinCC 客户端访问 WebNavigator 服务器时，用

作终端客户端的 WebNavigator 客户端决不可在会话中打开 Windows 桌面。 

可通过以下方式防止 WebNavigator 客户端在会话开始时打开 Windows 桌面。

● 在终端服务组态中直接输入所有用户。

● 在“计算机管理”(Computer Management) 中，输入 Internet Explorer 作为各用户的启

动程序。

2.6.2 终端服务的安装

简介     

以下章节介绍如何设置与 WebNavigator 客户端有关的终端服务。

先决条件

● WinCC 基本系统和 WebNavigator 服务器不以终端服务方式运行。

● 在激活终端服务执行以下组态步骤之前，必须已在服务器上安装 WinCC 基本系统和 
WebNavigator 服务器。

组态步骤

1. 在终端服务器上激活终端服务

2. 在终端服务器上安装应用程序，例如 WebNavigator 客户端。 在相应的文件和在线帮助中可
以找到有关安装的信息。

3. 在终端服务器上，创建用户以通过终端服务进行访问。

4. 在终端客户端上运行该应用程序。

有关更多信息，请参见 Microsoft 在线帮助中的“终端服务”。
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2.6.3 在 Windows 服务器上激活终端服务

简介     

在安装实际的应用程序（例如 WebNavigator 客户端）之前，激活服务器上的终端服务。 

使用控制面板中的“添加或删除程序”(Add or Remove Programs) 对话框在服务器上安装

应用程序。 这使所有用户都能够组态应用程序。 如果以其它方式安装应用程序，则只有实

际安装应用程序的用户才能使用它。

先决条件 

● Windows 管理员权限

● Windows 服务器

步骤 

1. 打开控制面板并双击“软件”(Software)。

2. 在“软件”(Software) 对话框中单击“添加/删除 Windows 组件”(Add/Remove Windows 
Components)。将打开“Windows 组件向导”(Windows Components Wizard)。

3. 激活“终端服务器”(Terminal Server) 和“终端服务器许可证”(Terminal Server Licensing)。

4. 单击“下一步”(Next)。 按照说明操作。

2.6.4 创建访问终端服务器的用户

先决条件  

● 已安装终端服务器。

● 已创建 Windows 用户。

步骤

1. 通过控制面板打开“计算机管理”(Computer Management)。 选择“本地用户和组”(Local 
Users and Groups)。

2. 双击“用户”(Users) 文件夹。

3. 双击要授权访问终端服务的用户。

4. 单击“隶属于”(Member of) 选项卡。 单击“添加”(Add)。 将打开“选择组”(Select Groups) 
对话框。
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5. 添加“远程桌面用户”(Remote Desktop Users) 组。单击“确定”(OK) 关闭所有打开的对话
框。

6. 检查其它组中用户的成员资格。 根据需要向其它组添加用户来分配必要的用户权限。

7. 关闭“计算机管理”(Computer Management)。

2.6.5 在终端客户端上启动终端服务器

先决条件     

● 已在 Windows 服务器上启动了终端服务。

● 在终端服务器上，已创建用于进行访问的用户。

步骤

1. 在终端客户端上，从 Windows“开始”(Start) 菜单中选择“程序 > 附件 > 通信 > 远程桌面连
接”(Programs > Accessories > Communication > Remote Desktop Connection)。 将打
开“远程桌面连接”(Remote Desktop Connection) 对话框。

2. 输入终端服务器的名称。

3. 单击“连接”(Connect)。 使用在终端服务器上创建的访问用户登录。

结果

然后，将会建立起连接。 将显示终端服务器的桌面。 在终端服务器上启动一个应用程序，

例如通过 Internet Explorer 启动 WebNavigator 客户端。
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2.7 附录

2.7.1 故障检测

WebNavigator 服务器和 WebNavigator 客户端之间的通信中断     

如果供应商在 Internet 连接中设置了“内容过滤”（如代理服务器、防火墙），则 
WebNavigator 通信将中断。使用内容过滤后，只能显示某些 HTML 页面内容。通信通过

一个定义的端口路由至一个 IP 地址，例如 WinCC 服务器地址。

禁用 WebNavigator 服务器上的 IP 地址智能过滤。因为 WinCC 服务器上没有 HTML 内
容，因此任何情况下过滤都不会起到特别作用。

如果使用 SSL 技术，数据将采用加密的形式传送。这种情况下，无法实现内容的智能过

滤。

连接中止

在 Internet 环境中，可能会发生连接故障、延迟和通信波动。 

如果 WebNavigator 客户端和 WebNavigator 服务器之间的通信中断，WebNavigator 客户

端将向用户输出一条消息。WebNavigator 客户端随后将尝试自动建立连接，以便恢复连

接。 

通过 "Web Configurator" 设置两次连接尝试之间的等待时间。如果数值设置为“0”，则 
WebNavigator 客户端将不会尝试自动重新连接。在这种情况下，WebNavigator 客户端会

输出一条消息，询问用户是否重新建立连接。 

确认此提示以重新建立连接。
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没有显示画面

检查是否在 WebNavigator 服务器上激活了正确的网页。

多标签浏览

要在 Internet Explorer 中启用多标签浏览，需要用到 "ControlHost.exe" 进程。 

在地址栏中向服务器名称后追加 "?inplacecontrol=no" 时，WebNavigator 客户端不再托管

于 ControlHost 中，而是托管于 Internet Explorer 中。这意味着将无法实现多标签浏览，

并会输出“已禁用多查看器实例”(Multiple viewer instance disabled) 消息。

演示模式

如果 WebNavigator 服务器上缺少所需的许可证，将显示一条相关的消息，并且 
WebNavigator 客户端将以演示模式运行。在此模式下，WebNavigator 客户端可正常运

行 30 天。30 天之后，将显示错误消息“服务器上仍没有许可证，演示模式过期”(Still no 
License on Server, Demo mode expired)。WebNavigator 客户端将无法再连接到 
WebNavigator 服务器。

自 Internet Explorer 8 开始的安全级别

默认情况下，Windows 7 下的 Internet Explorer 8 会激活保护模式。 

保护模式激活时，将无法连接到 WebNavigator 服务器。将显示错误消息“不支持低完整

性级别。请禁用保护模式”(Low integrity level is not supported. Please deactivate protected 
mode)。

在“工具 > Internet 选项 > 安全”(Tools > Internet Options > Security) 中禁用该模式。 
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无法连接到 WebNavigator 服务器

以下部分列出了造成 WebNavigator 客户端无法连接到 WebNavigator 服务器的若干错误

消息和原因：

● “WinCC 服务器当前未激活”(The WinCC Server is currently not active)：
运行系统中未启动服务器。

● “用户名或密码未知”(Unknown user name or password)：
此错误只会出现在 WinCCViewerRT 中。存储或输入的用户名或密码不正确。Internet 
Explorer 允许连续三次输入用户名和密码。之后将显示“HTTP 错误 401.1”错误页面。

说明

密码区分大小写。

● “已达到最大用户数”(Maximum count of users reached)：
已超过 WebNavigator 服务器的 WinCC/WebNavigator 许可证数。

● “所有许可证均在使用中，因此达到了可同时进行的客户端连接的最大数”(Maximum 
number of simultaneous client connections reached as all licenses are in use)：
分配可用的 WinCC/WebNavigator 许可证。

如果在 WinCC 系统中也使用 WinCC/WebUX 选件，则 WebUX 客户端也会占用一个 
WebNavigator 许可证。这样会使可用的 WebNavigator 许可证数减少。

● “服务器工作负载超出限制”(Server workload exceeds limit)：
已超过最大并发连接数。在 WinCC 项目管理器的“WebNavigator > Web 设置 > 运行系

统”(WebNavigator > Web settings > Runtime) 下进行此项设置。连接到服务器的客户

端数量显示在“http://<服务器名称>/status.html”页面。并发连接数可以超过所连接的客

户端数，例如，在浏览器窗口中打开了多个选项卡。 

● “已达到最大选项卡数”(Maximum count of tabs reached)：
已超过每个浏览器的最大选项卡数。在 WinCC 项目管理器的“WebNavigator > Web 设
置 > 运行系统”(WebNavigator > Web settings > Runtime) 下进行此项设置。
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● “没有与服务器的连接”(No connection to server)：
无法访问服务器。错误的具体原因不明。有关诊断信息，请参见“http://<服务器名称>/
status.html”页面。

说明

如果 WebNavigator 客户端为 64 位计算机，则必须在该计算机上安装“Visual C++ 2010 
Redistributable”。必须在建立连接之前进行此安装。

可通过“MainControl.asp”的 Navigation 用户界面“下载区域”(download area) 中
的“Web Navigator 和系统更新”(Web Navigator and System Updates) 菜单安装该软件。

如果与较旧版本的 WebNavigator 服务器相连，则链接不可用。然后可通过“https://
www.microsoft.com/en-in/download/details.aspx?id=14632”安装“Visual C++ 2010 
Redistributable”。

● “无法加载 http://<服务器名称>/Pictures/For_example.PD_”(Failed to load http://
<servername>/Pictures/For_example.PD_)：
访问组态的起始画面失败。检查 WebNavigator 服务器上的授权。发布的画面在服务器

上可能不再可用。

不正确的起始画面

在图形编辑器中已编辑了新画面。

1. 启动 Web View Publisher 以发布新画面。

2. 在 Internet Explorer 中选择“工具 > Internet 选项”(Tools > Internet Options)，删除临时 
Internet 文件。

3. 可在“用户管理”(User Administration) 中为每个用户分配一个起始画面。

参见

检查激活的网页 (页 73)

2.7.2 函数

2.7.2.1 支持的函数

简介

下表显示了 WebNavigator 支持的函数。 

此列表中未包括的函数不会在 WebNavigator 中自动启用。
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函数             

WaitForDocumentReady  

Get_Focus GetTagChar

GetAssignments GetTagCharState

GetBasePicture GetTagCharStateWait

GetFlashPicture GetTagCharWait

GetFontName GetTagMultiStateWait

GetInputValueChar GetTagMultiWait

GetLastChange GetText

GetOutputFormat SetTagMultiWait

GetOutputValueChar SetTagMultiStateWait

GetPictureName SetTagRaw

GetPropChar SetTagRawState

GetServerName SetTagRawStateWait

AXC_OnBtnArcLong AXC_OnBtnMsgNext

AXC_OnBtnArcShort AXC_OnBtnMsgPrev

AXC_OnBtnComment AXC_OnBtnMsgWin

AXC_OnBtnEmergAckn AXC_OnBtnScroll

AXC_OnBtnInfo AXC_OnBtnSelect

AXC_OnBtnLock AXC_OnBtnSinglAckn

AXC_OnBtnLoop AXC_OnBtnVisibleAckn

AXC_OnBtnMsgFirst AXC_SetFilter

AXC_OnBtnMsgLast  

OnBtnArcLong OnBtnMsgLast

OnBtnArcShort OnBtnMsgNext

OnBtnComment OnBtnMsgPrev
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OnBtnEmergAckn OnBtnMsgWin

OnBtnHornAckn OnBtnPrint

OnBtnInfo OnBtnScroll

OnBtnLanguage OnBtnSelect

OnBtnLock OnBtnSinglAckn

OnBtnLoop OnBtnVisibleAckn

OnBtnMsgFirst  

TLGGetTemplateParameter TlgTableWindowPressPrevButton

TLGPressToolbarButton TlgTableWindowPressPrevItemButton

TlgGetColumnPosition TlgTableWindowPressStartStopButton

TlgGetNumberOfColumns TlgTrendWindowPressFirstButton

TlgGetNumberOfRows TlgTrendWindowPressLastButton

TlgGetNumberOfTrends TlgTrendWindowPressLinealButton

TlgGetRowPosition TlgTrendWindowPressNextButton

TlgGetRulerArchivNameTrend TlgTrendWindowPressNextItemButton

TlgGetRulerTimeTrend TlgTrendWindowPressOneToOneButton

TlgGetRulerValueTrend TlgTrendWindowPressOpenArchiveVariableSelecti
onDlgButton

TlgGetRulerVariableNameTrend TlgTrendWindowPressOpenDlgButton

TlgGetTextAtPos TlgTrendWindowPressOpenItemSelectDlgButton

TlgTableWindowPressFirstButton TlgTrendWindowPressOpenTimeSelectDlgButton

TlgTableWindowPressLastButton TlgTrendWindowPressPrevButton

TlgTableWindowPressNextButton TlgTrendWindowPressPrevItemButton

TlgTableWindowPressNextItemButton TlgTrendWindowPressStartStopButton

TlgTableWindowPressOpenArchiveVariableSelecti
onDlgButton

 TlgTrendWindowPressZoomInButton

TlgTableWindowPressOpenItemSelectDlgButton TlgTrendWindowPressZoomOutButton

TlgTableWindowPressOpenTimeSelectDlgButton  
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GetLanguage GetParentPicture

SetLanguage GetParentPictureWindow

GetLink GetServerTagPrefix

SetLink OpenPicture

GetLinkedVariable SetPictureDeactivated

GetLocalPicture SetPictureDown

SetMultiLink SetPictureUp

_makepath fscanf setvbuf

_splitpath fsetpos sprintf 

abs ftell srand

abort fwrite sscanf 

asctime getc strcat

atexit  getchar strcmp

atof getenv strcpy

atoi gets strchr

atol gmtime strcspn

bsearch labs strerror

calloc ldiv strftime

clearerr localtime strlen

clock malloc strncat 

ctime memchr strncmp

difftime memcmp strncpy

div memcpy strpbrk

exit memmove strrchr

fclose memset strspn

feof mktime strstr

ferror perror strtod

fflush printf strtok

fgetc putc strtol

WinCC/WebNavigator 文档

2.7 附录

WinCC/WebNavigator
系统手册, 02/2017 113



fgetpos putchar strtoul

 fgets puts SysMalloc

fopen qsort system

fprintf rand time

fputc realloc  ungetc

fputs  remove vfprintf

freopen rename vprintf 

fread rewind vsprintf

free scanf  

fseek setbuf  

Check ProgramExecute

GetActualPointLeft GetExponent GetPicDeactTransparent

GetActualPointTop GetExtendedOperation GetPicDeactUseTransColor

GetAdaptBorder GetFillColor GetPicDownReferenced

GetAdaptPicture GetFilling GetPicDownTransparent

GetAdaptSize GetFillingIndex GetPicDownUseTransColor

GetAlarmHigh GetFillStyle GetPicReferenced

GetAlarmLow GetFillStyle2 GetPicTransColor

GetAlignment GetFlashBackColor GetPicUpReferenced

GetAlignmentLeft GetFlashBorderColor GetPicUpTransparent

GetAlignmentTop GetFlashFlashPicture GetPicUpUseTransColor

GetAssumeOnExit GetFlashForeColor GetPicUseTransColor

GetAssumeOnFull GetFlashPicReferenced GetPictureDeactivated

GetAverage GetFlashPicTransColor GetPictureDown

GetAxisSection GetFlashPicUseTransColor GetPictureUp

GetBackBorderWidth GetFlashRateBackColor GetPointCount

GetBackColor GetFlashRateBorderColor GetPosition

GetBackColor2 GetFlashRateFlashPic GetPressed
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GetBackColor3 GetFlashRateForeColor GetProcess

GetBackColorBottom GetFontBold GetPropBOOL

GetBackColorTop GetFontItalic GetPropDouble

GetBackFlashColorOff GetFontSize GetPropLong

GetBackFlashColorOn GetFontUnderline GetPropWord

GetBasePicReferenced GetForeColor GetRadius

GetBasePicTransColor GetForeFlashColorOff GetRadiusHeight

GetBasePicUseTransColor GetForeFlashColorOn GetRadiusWidth

GetBitNumber GetGrid GetRangeMax

GetBorderBackColor GetGridColor GetRangeMin

GetBorderColor GetGridHeight GetReferenceRotationLeft

GetBorderColorBottom GetGridWidth GetReferenceRotationTop

GetBorderColorTop GetHeight GetRightComma

GetBorderEndStyle GetHiddenInput GetRotationAngle

GetBorderFlashColorOff GetHotkey GetRoundCornerHeight

GetBorderFlashColorOn GetHysteresis GetRoundCornerWidth

GetBorderStyle GetHysteresisRange GetScaleColor

GetBorderWidth GetIndex GetScaleTicks

GetBoxAlignment GetInputValueDouble GetScaling

GetBoxCount GetItemBorderBackColor GetScalingType

GetBoxType GetItemBorderColor GetScrollBars

GetButtonColor GetItemBorderStyle GetSelBGColor

GetCaption GetItemBorderWidth GetSelTextColor

GetCheckAlarmHigh GetLanguageSwitch GetSizeable

GetCheckAlarmLow GetLayer GetSmallChange

GetCheckLimitHigh4 GetLeft GetStartAngle

GetCheckLimitHigh5 GetLeftComma GetToggle

GetCheckLimitLow4 GetLimitHigh4 GetToleranceHigh

GetCheckLimitLow5 GetLimitHigh5 GetToleranceLow

GetCheckToleranceHigh GetLimitLow4 GetTop

GetCheckToleranceLow GetLimitLow5 GetTrend

GetCheckWarningHigh GetLimitMax GetTrendColor
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GetCheckWarningLow GetLimitMin GetTypeAlarmHigh

GetClearOnError GetListType GetTypeAlarmLow

GetClearOnNew GetLongStrokesBold GetTypeLimitHigh4

GetCloseButton GetLongStrokesOnly GetTypeLimitHigh5

GetColorAlarmHigh GetLongStrokesSize GetTypeLimitLow4

GetColorAlarmLow GetLongStrokesTextEach GetTypeLimitLow5

GetColorBottom GetMarker GetTypeToleranceHigh

GetColorChangeType GetMax GetTypeToleranceLow

GetColorLimitHigh4 GetMaximizeButton GetTypeWarningHigh

GetColorLimitHigh5 GetMin GetTypeWarningLow

GetColorLimitLow4 GetMoveable GetUnselBGColor

GetColorLimitLow5 GetNumberLines GetUnselTextColor

GetColorToleranceHigh GetOffsetLeft GetUpdateCycle

GetColorToleranceLow GetOffsetTop GetVisible

GetColorTop GetOnTop GetWarningHigh

GetColorWarningHigh GetOperation GetWarningLow

GetColorWarningLow GetOperationMessage GetWindowBorder

GetCursorControl GetOperationReport GetWindowsStyle

GetDataFormat GetOrientation GetWidth

GetDirection GetOutputValueDouble GetZeroPoint

GetEditAtOnce GetPasswordLevel GetZeroPointValue

GetEndAngle GetPicDeactReferenced GetZoom

Set_Focus SetEditAtOnce SetPicDownUseTransColor

SetActualPointLeft SetEndAngle SetPicTransColor

SetActualPointTop SetExponent SetPicUpTransparent

SetAlarmHigh SetExtendedOperation SetPicUpUseTransColor

SetAlarmLow SetFillColor SetPicUseTransColor

SetAlignment SetFilling SetPictureName

SetAlignmentLeft SetFillingIndex SetPointCount

SetAlignmentTop SetFillStyle SetPosition
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SetAssumeOnExit SetFillStyle2 SetPressed

SetAssumeOnFull SetFlashBackColor SetProcess

SetAverage SetFlashBorderColor SetPropBOOL

SetAxisSection SetFlashFlashPicture SetPropDateTime

SetBackBorderWidth SetFlashForeColor SetPropChar

SetBackColor SetFlashPicTransColor SetPropDouble

SetBackColor2 SetFlashPicUseTransColor SetPropLong

SetBackColor3 SetFlashRateBackColor SetPropWord

SetBackColorBottom SetFlashRateBorderColor SetRadius

SetBackColorTop SetFlashRateFlashPic SetRadiusHeight

SetBackFlashColorOff SetFlashRateForeColor SetRadiusWidth

SetBackFlashColorOn SetFontBold SetRangeMax

SetBasePicTransColor SetFontItalic SetRangeMin

SetBasePicUseTransColor SetFontName SetRightComma

SetBitNumber SetFontSize SetReferenceRotationLeft

SetBorderBackColor SetFontUnderline SetReferenceRotationTop

SetBorderColor SetForeColor SetRotationAngle

SetBorderColorBottom SetForeFlashColorOff SetRoundCornerHeight

SetBorderColorTop SetForeFlashColorOn SetRoundCornerWidth

SetBorderEndStyle SetHeight SetScaleColor

SetBorderFlashColorOff SetHiddenInput SetScaleTicks

SetBorderFlashColorOn SetHysteresis SetScaling

SetBorderStyle SetHysteresisRange SetScalingType

SetBorderWidth SetIndex SetSelBGColor

SetBoxAlignment SetItemBorderBackColor SetSelTextColor

SetBoxCount SetItemBorderColor SetSmallChange

SetBoxType SetItemBorderStyle SetStartAngle

SetButtonColor SetItemBorderWidth SetText

SetCheckAlarmHigh SetLeft SetTop

SetCheckAlarmLow SetLeftComma SetTrend

SetCheckLimitHigh4 SetLimitHigh4 SetTrendColor

SetCheckLimitHigh5 SetLimitHigh5 SetToleranceHigh
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SetCheckLimitLow4 SetLimitLow4 SetToleranceLow

SetCheckLimitLow5 SetLimitLow5 SetToggle

SetCheckToleranceHigh SetLimitMax SetTypeAlarmHigh

SetCheckToleranceLow SetLimitMin SetTypeAlarmLow

SetCheckWarningHigh SetLongStrokesBold SetTypeLimitHigh4

SetCheckWarningLow SetLongStrokesOnly SetTypeLimitHigh5

SetClearOnError SetLongStrokesSize SetTypeLimitLow4

SetClearOnNew SetMarker SetTypeLimitLow5

SetColorAlarmHigh SetMax SetTypeToleranceHigh

SetColorAlarmLow SetMin SetTypeToleranceLow

SetColorBottom SetNumberLines SetTypeWarningHigh

SetColorChangeType SetOffsetLeft SetTypeWarningLow

SetColorLimitHigh4 SetOffsetTop SetUnselBGColor

SetColorLimitHigh5 SetOperation SetUnselTextColor

SetColorLimitLow4 SetOperationMessage SetVisible

SetColorLimitLow5 SetOperationReport SetWarningHigh

SetColorToleranceHigh SetOrientation SetWarningLow

SetColorToleranceLow SetOutputValueChar SetWindowsStyle

SetColorTop SetOutputValueDouble SetWidth

SetColorWarningHigh SetPasswordLevel SetZeroPoint

SetColorWarningLow SetPicDeactTransparent SetZeroPointValue

SetCursorControl SetPicDeactUseTransColor SetZoom

SetDirection SetPicDownTransparent  

GetTagBit GetTagDateTime GetTagByteStateQCWait

GetTagByte GetTagDoubleWait GetTagCharStateQC

GetTagDouble GetTagDWordWait GetTagCharStateQCWait

GetTagDWord GetTagFloatWait GetTagDoubleStateQC

GetTagFloat GetTagRawWait GetTagDoubleStateQCWait

GetTagRaw GetTagSByteWait GetTagDWordStateQC

GetTagSByte GetTagSDWordWait GetTagDWordStateQCWait
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GetTagSDWord GetTagSWordWait GetTagFloatStateQC

GetTagSWord GetTagWordWait GetTagFloatStateQCWait

GetTagWord GetTagBitStateWait GetTagRawStateQC

GetTagBitState GetTagByteStateWait GetTagRawStateQCWait

GetTagByteState GetTagDoubleStateWait GetTagSByteStateQC

GetTagDoubleState GetTagDWordStateWait GetTagSByteStateQCWait

GetTagDWordState GetTagFloatStateWait GetTagSDWordStateQC

GetTagFloatState GetTagRawStateWait GetTagSDWordStateQCWait

GetTagRawState GetTagSByteStateWait GetTagSWordStateQC

GetTagSByteState GetTagSDWordStateWait GetTagSWordStateQCWait

GetTagSDWordState GetTagSWordStateWait GetTagValueStateQC

GetTagSWordState GetTagWordStateWait GetTagValueStateQCWait

GetTagWordState GetTagBitStateQC GetTagWordStateQC

GetTagBitWait GetTagBitStateQCWait GetTagWordStateQCWait

GetTagByteWait GetTagByteStateQC GetTagMultiStateQCWait

SetTagBit SetTagFloatState SetTagSWordWait

SetTagByte SetTagRawState SetTagWordWait

SetTagDouble SetTagSByteState SetTagBitStateWait

SetTagDWord SetTagSDWordState SetTagByteStateWait

SetTagFloat SetTagSWordState SetTagDoubleStateWait

SetTagRaw SetTagWordState SetTagDWordStateWait

SetTagSByte SetTagBitWait SetTagFloatStateWait

SetTagSDWord SetTagByteWait SetTagRawStateWait

SetTagSWord SetTagDoubleWait SetTagSByteStateWait

SetTagWord SetTagDWordWait SetTagSDWordStateWait

SetTagBitState SetTagFloatWait SetTagSWordStateWait

SetTagByteState SetTagRawWait SetTagWordStateWait

SetTagDoubleState SetTagSByteWait  

SetTagDWordState SetTagSDWordWait  
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支持的 ODK 函数

PWRTCheckPermission  

PWRTCheckPermissionOnPicture // 只计算参数“permlevel”的值！ 

MSRTStartMsgService  

MSRTStopMsgService  

MSRTCreateMsg  

MSRTCreateMsgInstanceWithComment

MSRTSetComment

PDLRTGetLink

PDLRTSetLink

PDLRTSetMultiLink

PDLRTGetPropEx // 仅支持读取。

PDLRTSetPropEx // 仅支持设置。

TXTRTConnect

TXTRTDisconnect

TXTRTGetInfoTextMC

支持的用户归档函数

说明

用户归档函数必须始终以小写字母“ua”开头。 
以大写字母“UA”开头的函数是 ODK 函数。 WebNavigator 客户端不支持这些 ODK 函数。

uaArchiveClose uaArchiveGetName uaArchiveSetFieldValueLong

uaArchiveDelete uaArchiveGetSort uaArchiveSetFieldValueString

uaArchiveExport uaArchiveImport uaArchiveSetFilter

uaArchiveGetCount uaArchiveInsert uaArchiveSetSort

uaArchiveGetFieldLength uaArchiveMoveFirst uaArchiveUpdate

uaArchiveGetFieldName uaArchiveMoveLast uaArchiveWriteTagValues
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uaArchiveGetFields uaArchiveMoveNext uaArchiveWriteTagValuesByNam
e

uaArchiveGetFieldType uaArchiveMovePrevious uaConnect

uaArchiveGetFieldValueDate uaArchiveOpen uaDisconnect

uaArchiveGetFieldValueFloat uaArchiveReadTagValues uaGetLastError

uaArchiveGetFieldValueDouble uaArchiveReadTagValuesByNam
e

uaGetLastHResult

uaArchiveGetFieldValueLong uaArchiveRequery uaQueryArchive

uaArchiveGetFieldValueString uaArchiveSetFieldValueDate uaQueryArchiveByName

uaArchiveGetFilter uaArchiveSetFieldValueDouble uaReleaseArchive

uaArchiveGetID uaArchiveSetFieldValueFloat  

支持的 MBCS 函数

_ismbcalnum _mbscat _mbsncmp

_ismbcalpha _mbschr _mbsncpy

_ismbcdigit _mbscmp _mbsnicmp

_ismbcgraph _mbscpy _mbspbrk

_ismbclower _mbsdec _mbsrchr

_ismbcprint _mbsicmp _mbsspn

_ismbcpunct _mbsinc _mbsstr

_ismbcspace _mbslen _mbstok

_ismbcupper _mbscspn _mbctolower

_mbclen _mbsncat _mbctoupper

2.7.2.2 WaitForDocumentReady

函数     

该函数检查画面是否已加载到指定的画面窗口中。
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必须对 WinCC 运行系统环境与 WebNavigator 客户端运行系统环境中的过程画面或项目函

数的脚本加以区分。 为此，需要以下编译器命令：

● #ifdef RUN_ON_WEBNAVIGATOR

● #ifndef RUN_ON_WEBNAVIGATOR

以便在组态中的以下方面对 WinCC 和 WebNavigator 客户端加以区分：

● 使用“WaitForDocumentReady”实现的脚本延迟

● 画面寻址不同

● 控制系统函数的函数名称不同

● WebNavigator 客户端中不支持的函数

ANSI-C 语法

int WaitForDocumentReady(LPCSTR lpszPictureWindow)

参数

lpszPictureWindow

指向在 WebNavigator 客户端中打开的画面窗口名称的指针。

可以使用以下寻址语法：

● 当前画面中的画面窗口“xxx”： ./xxx

● 视图对象“xxx”中的画面窗口“yyy”： ./xxx/yyy

● 父画面中的画面窗口“xxx”： ../xxx

● 父画面的父画面中的画面窗口“xxx”： ../../xxx

● 与 WinCC 兼容的绝对路径

返回值

TRUE

已找到画面窗口并检查状态。

FALSE

未找到画面窗口。
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ANSI-C 示例
#ifdef RUN_ON_WEBNAVIGATOR
SetPropChar("../", "View", "PictureName", szViewName);
WaitForDocumentReady("../View");
#else
SetPropChar(lpszParent, "View", "PictureName", szViewName);
#endif

说明

编译 WinCC 脚本过程中不检查 WebNavigator 代码段的语法，仅在发布画面时检查。

2.7.2.3 不支持的函数

下表仅节选了部分不支持的函数。 该列表包含显式声明为不受支持的函数。 

函数     

GetHWDiag OnDeactivateExecute ReportJob

GetHWDiagLevel OnErrorExecute RPTJobPreview

GetKopFupAwl OnTime RPTJobPrint

GetKopFupAwlLevel OpenPrevPicture RptShowError 

VBScript 函数

● HMIRuntime.Stop： 终止 Internet Explorer 和 WinCCViewerRT，但不终止 WinCC 
Runtime。

● AlarmLogs 对象

● DataLogs 对象

● Logging 对象

● Project 对象

不需要的函数：

● DeactivateRTProject： 终止 Internet Explorer 和 WinCCViewerRT，但不终止 WinCC 
Runtime。

● ExitWinCC

● FillDiagnoseInTags
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● InquireLanguage

● TraceText

● TraceTime

其它函数

这些函数包括在函数范围内以确保在 WebNavigator 客户端上编译时没有错误。 
WebNavigator 客户端不支持这些函数。

AXC_OnBtnHornAckn GetCursorMode GmsgFunction  

AXC_OnBtnPrint SetCursorMode MSRTMsgWinCommand

AXC_OnBtnProtocol  TlgTableWindowPressHelpButton
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ActiveX 控件, 99

F
FAQ, (请参见更正措施)

I
IIS, (参见 Internet 信息服务)
Internet Explorer, 87

安全设置, 22
Internet 信息服务, 64

检查激活的网页, 21, 73
启动网页, 21, 73

O
OPC 通道, 38

P
PdlPad, 48
Plug-in Builder, 99

创建插件并使其可供下载, 101

S
SIMATIC Logon, 62

V
Visual Basic 脚本

用于 WebNavigator, 80

W
Web Configurator, 64

创建标准网页, 66
创建虚拟目录, 68
设置 Internet 信息服务, 64
设置端口, 66
组态防火墙, 19, 71

Web Navigation 界面, 88, 89
Web View Publisher, (参见 Web 发布器)
Web 查看器, 24, 27, 35, 92, 95
Web 发布器

发布过程画面, 45, 48
使用 PdlPad 检查脚本, 48
要求, 47

Web 发布向导, (参见 Web 发布器)
Web 客户端, (请参见 WebNavigator 客户端)
Web 设置, 56, 60, (参见 Web Configurator)
Web 项目, 44

Web 查看器, 24, 35, 92
Web 设置, 56, 60
发布过程画面, 45, 47, 48
镜像 WinCC 项目, 38
使用 PdlPad 检查脚本, 48
使用脚本, 80
限制, 79
与 WinCC 基本系统的不同之处, 82

Web 选项, 62
WebNavigator

Web 项目, 44, 56, 60
Web 项目的限制, 79
发布过程画面, 45, 47, 48
负载平衡, 73, 76
函数, 111, 123
脚本中的预处理器定义, 80
使用变量, 82
使用脚本, 80
小工具, 57
用户管理, 62
与 WinCC 基本系统的不同之处, 80, 82
终端服务, 43, 104, 105, 106
组态步骤, 44

WebNavigator 服务器, 35
编辑组态, 64
初始组态, 64
独立的解决方案, 37
负载平衡, 73, 76
使用 PdlPad 检查脚本, 48
诊断, 90
专用的 Web 服务器, 40
组态 WinCC 服务器, 37, 38, 40

WebNavigator 客户端, 35, 83, 87
Plug-in, 99
Plug-in Builder, 99
Web 选项, 62
函数, 83
画面, 86
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画面更改, 82
画中画方法, 80
通过终端服务访问, 104
硬拷贝功能, 96
自动建立连接, 83
自动注销, 62

WebNavigator 诊断服务器, 42
WebNavigator 诊断客户端, 35, 42
WinCC 服务器

组态 WebNavigator 服务器, 37, 38
WinCC 客户端

通过终端服务访问, 104
WinCC 项目, (参见 Web 项目)
WinCC 用户管理器, (参见用户管理器)
WinCC/WebNavigator 诊断服务器, (请参见 
WebNavigator 诊断服务器)
WinCC/WebNavigator 诊断客户端, (请参见 
WebNavigator 诊断客户端)
WinCCViewerRT, 24, 27, 33, 62, 92, 95, (请参见 Web 
查看器)

安

安装
WebNavigator 客户端, 22
安全设置, 22

保

保持, 83

标

标准网页, 66

独

独立的解决方案, 37

端

端口
设置, 66

发

发布插件, 101

防

防火墙
Windows 2008, 19, 71
Windows 7, 19, 71

负

负载分配, (参见负载平衡)
负载平衡, 73

组态, 76

更

更正措施
连接中止, 107

滚

滚动条控件, 83

过

过程画面, 86
发布, 45, 47, 48

过程总线, 38

函

函数
不支持的函数, 123
打开画面窗口, 121
支持的 MSBC 函数, 111
支持的 ODK 函数, 111
支持的函数, 111
支持的用户归档函数, 111

脚

脚本
函数, 121

截

截图, (参见硬拷贝)
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全

全局脚本
用于 WebNavigator, 80

入

入门指南, 14, 16, 19, 30, 32
更改过程画面, 29, 32
组态 WebNavigator 服务器, 16, 19

授

授权
组态 Web 选项, 62

通

通信, 38

系

系统授权, 62

小

小工具, 57

虚

虚拟目录, 68

硬

硬拷贝, 96

用

用户改变, 24, 92
用户管理器

Web 选项, 62
WebNavigator 的用户管理, 62

与

与语言相关的文本, 83

远

远程发布, 45, 47, 48

诊

诊断
WebNavigator 服务器, 90

终

终端服务, 43
激活, 105
启动终端服务服务器, 106
设置, 104
设置用户, 105
通信, 104

终端服务服务器, (请参见终端服务)
终端服务客户端, (请参见终端服务)
终端服务器, (请参见终端服务)

专

专用的 Web 服务器, 40
发布过程画面, 45, 47, 48
画面更改, 86

组

组态, 64
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